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Upozornění 

Tato publikace není oficiálním manuálem společnosti Interactive Brokers a není ani jejím překladem. 
Tato publikace vznikla na základě našich vlastních zkušeností a poznatků s touto platformou a je tedy 
třeba i takto k publikaci přistupovat. Obzvláště pak apelujeme, berte v patrnost veškerá důležitá 
upozornění přímo v obsahu této publikace. 

Veškeré uvedené informace, metody a postupy nejprve důrazně doporučujeme odzkoušet v 
demoverzi platformy. Nic netestujte na svém „živém“ účtu, dokud jste si vše potřebné dostatečně 
nevyzkoušeli v rámci demoverze IB platformy. Autoři této publikace nenesou jakoukoliv 
zodpovědnost za ztráty spojené s případnou nevhodnou manipulací platformy IB. 

Publikace vzhledem k všestrannosti a komplexnosti platformy IB neobsahuje zdaleka veškeré možné 
funkce, volby a možnosti práce s touto platformou. Publikace si klade za cíl pouze a jen seznámit 
běžného uživatele se základními nástroji a volbami potřebnými pro intradenní´obchodování. Funkce a 
nástroje z našeho pohledu pro daytrading nepodstatné nejsou v publikaci blíže popsané. Kompletní 
popis všech funkcí a nástrojů lze najít na samotné stránce Interactive Brokers. 

Dále čtenáře této publikace prosíme - berte na vědomí i skutečnost, že se platforma IB neustále vyvíjí 
a prakticky každý měsíc přichází IB s novou verzí. Tato publikace odráží popis aktuální verze 848.8, je 
však pravděpodobné, že se budoucí verze platformy mohou v mnoha ohledech lišit. 

Tato publikace pak není ani žádným konkrétním návodem, jak obchodovat a autoři publikace se 
důrazně distancují od jakékoliv zodpovědnosti za obchody provedené čtenáři a uživateli této 
publikace.  

Publikace je chráněna autorským zákonem a jakékoliv její šíření bez předešlého souhlasu autorů je 
trestné.  

Publikace obsahuje prvky, které v případě odhalení volného šíření této publikace bez souhlasu autorů 
mohou identifikovat jedince, od kterého volné šíření začalo. Autoři publikace nebudou váhat uplatnit 
autorský zákon v případě takového zjištění. 
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1 Úvod 

Společnost Interactive Brokers patří mezi výrazného hráče na poli brokerských služeb. Společnost 
Interactive Brokers je do jisté míry výrazným průkopníkem v této branži a právě jí vděčíme za 
úžasnou možnost obchodovat na prakticky libovolných trzích za poplatky, o kterých se nám dříve ani 
nesnilo. Tak jako společnost Ryanair přišla před lety s průkopnickou ideou nabídnout leteckou 
dopravu za ultra-nízké ceny a výrazně tak zamíchala se situací na trhu letecké přepravy, podařilo se i 
společnosti IB jako první na světě uvést v život ideu ultra-levných brokerských služeb. Samozřejmě, 
následovatelé se objevili – stejně jako v případě Ryanair – již zakrátko. Přesto však IB zůstává 
vlajkovou lodí mezi low-cost brokery a od nás všech jí patří velký dík za to, že dnes už 
neobchodujeme na trzích za nehorázné komise i kolem 80 USD/RT, ale za komise často i mnohem 
nižší než 5 USD/RT. Jaký to pokrok!  

Společnost Interactive Brokers však neusnula na vavřínech. Svůj business nadále buduje s výrazným 
každoročním pokrokem. Služby společnosti se rozšiřují a technická řešení nabízená společností IB 
procházejí až neuvěřitelným vývojem každý rok. Není to ještě tak dávno, co IB platforma ještě 
neuměla ani zobrazovat aktuální intradenní grafy. Dnes už je tato možnost samozřejmostí, nemluvě o 
množství indikátorů, které lze na grafech zobrazovat a používat. Společnost IB roste tempem sobě 
patřičným a zaručeně nám i v budoucnu připraví ještě nejedno příjemné překvapení. 

Samozřejmě je třeba zcela férově přiznat, že určitá výrazná „pro“ musí mít i svá „proti“. Daní za low-
cost služby může být například velmi slabá uživatelská podpora klientů společnosti IB. Pokud jste 
klientem IB, často se musíte spolehnout sami na sebe. Naštěstí to není až tak složité. Další nevýhodou 
je pak skutečně až přílišná univerzálnost platformy TWS, absence multijazyčných verzí a nějakého 
komplexnějšího a skutečně propracovaného uživatelského manuálu. A právě to je i důvod, proč jsme 
se rozhodli tento určitý „nedostatek“ kompenzovat alespoň formou této elektronické publikace (e-
book) – první a v tuto chvíli jedinou svého druhu v ČR a SR.  

Každý, kdo se rozhodne pro intradenní obchodování se společností Interactive Brokers, by tedy měl v 
této publikaci najít vše potřebné a bez větších problémů začít s platformou obchodovat. Dát 
dohromady tuto publikaci rozhodně nebylo snadné, proto pevně věříme, že informace v ní nalezené 
vám ušetří mnoho nervů, času, ale i peněz. Publikaci jsme se snažili vytvořit v podobě maximálně 
srozumitelné skutečně každému a zároveň do ní také vložit řadu tipů, ke kterým jsme se postupem 
času sami propracovali reálným obchodováním se společností IB. 

Přejeme vám tedy rychlé zvládnutí potřebných technických základů obsluhy IB platformy, kvalitní a 
přesné exekuce vašich příkazů a samozřejmě ze všeho nejvíce – mnoho dobrých a úspěšných 
obchodů. 

 
 
 
Petr Podhajský & Tomáš Nesnídal 

FINANČNÍK.CZ 
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2 Instalace platformy Trader Workstation 

Pro instalaci platformy proveďte následující kroky: 

1) Pro instalace plné platformy TWS klikněte na stránce www.interactivebrokers.com na 
Trading > Trading Platforms > tlačítko Trader Workstation (TWS) > tlačítko Windows 
Download > tlačítko Install TWS > poté následujte instalační instrukce podle obrázků 
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2) Pro instalaci demo platformy TWS klikněte na stránce www.interactivebrokers.com na 
Trading > Trading Platforms > tlačítko Trader Workstation (TWS) > v menu na Demo > poté 
na obrázek TWS Individual Demo „Try demo“. Po kliknutí vám nabídne internetový prohlížeč 
stažení a spuštění souboru. Proveďte spuštění a nechte načíst aplikaci Java a provést 
instalaci. Po dokončení se vám automaticky platforma spustí v DEMO módu. 

Pozn.: doporučujeme soubor uložit do vašeho počítače. Pomocí něj můžete demoverzi TWS 
kdykoliv opětovně spustit. 
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3 Přihlášení do platformy Trader Workstation 

K přihlášení do platformy  Trader Workstation potřebujete uživatelské jméno a heslo, které jste 
získali při zakládání svého účtu u Interactive Brokers. Tyto údaje vložte do přihlašovacího okénka, 
které se zobrazí po spuštění programu. Program lze spustit také v demorežimu, což je ideální způsob 
pro zkoumání platformy. V takovém případě se přihlaste následujícími údaji – jméno: edemo, heslo: 
demouser. 

Patrně není nutné zdůrazňovat, že přístupové údaje slouží k přístupu k vašemu obchodnímu účtu, tj. 
mělo by s nimi být nakládáno velmi obezřetně. Kdokoliv, kdo bude tyto údaje znát, může s vaším 
účtem pracovat. Ke zvýšení bezpečnosti doporučujeme při přihlašování zaškrtnout políčko Use SSL. 
Tím se aktivuje šifrování protokolem jakékoliv komunikace mezi platformou a serverem IB. Přenášení 
informací tedy nemůže být „odposloucháváno“ a následně zneužito třetími osobami. 

Změna hesla 

Dojde-li k prozrazení vašeho hesla, je nutné jej co nejdříve změnit. Učinit tak můžete s použitím 
webové služby Account Management, do které se můžete přihlásit na webu 
www.interactivebrokers.com (Login > Account Management Menu). Změnu hesla naleznete v levém 
menu pod položkou User Management > Password 
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4 Nastavení základní obrazovky Trader Workstation 

Po prvním přihlášení do programu se zobrazí podobná základní obrazovka, jakou vidíte na obr. 4.1.  

Pozn.: pokud se přihlašujete hned do ostrého účtu, je obrazovka podobná, ale prázdná. 

Pro úvodní zkoumání platformy rozhodně doporučujeme pracovat v demorežimu! 

 

Obr. 4.1 – základní (úvodní) obrazovka platformy TWS 

Základní pracovní prostor programu (obr. 4.1) obsahuje nahoře klasické menu, pod ním ikony pro 
nejdůležitější ovládání účtu (Order, Account a další) a do třetice „záložky“ obsahující ceny 
sledovaných finančních instrumentů. Na obr. 4.1 je screenshot z demoverze programu, která nemá 
přístupné všechny funkce. Proto je na screenshotu zobrazeno méně ikonek než v ostré verzi 
platformy. 

Nastavení vlastních sledovaných komodit 

Na obr. 4.1 vidíte, že základní okno obsahuje záložky US Stocks, US Options, EU Stocks a další – tedy 
záložky pro nejrůznější ceny akcií a opcí. Je jen na vás, jaké záložky si v platformě vytvoříte, jak se 
budou jmenovat a jaké finanční instrumenty budou obsahovat. 

Neobchodujete-li akcie, pak si patrně budete chtít záložku US Stocks úplně zrušit, aby vás v programu 
nerušila. 

http://www.financnik.cz/
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Pro zrušení záložky najeďte myší na název záložky a klikněte pravým tlačítkem myši. Zobrazí se 
kontextové menu, ve kterém vyberte volbu Delete. Následně je třeba vymazání záložky potvrdit 
kliknutím na OK v zobrazeném dialogovém okně. 

 

Obr. 4.2 – vymazání záložky se provede tak, že se na záložku klikne pravým tlačítkem 
myši a z kontextového menu vyberete volbu Delete 

V kontextovém menu zobrazeném po kliknutí pravým tlačítkem myši na název záložky jsou ještě další 
možnosti sloužící k nastavení prostředí tak, aby vyhovovalo našim potřebám. V položce Rename Page 
je možné si změnit jméno zobrazené záložky, přes položku Layout… si můžeme vybrat údaje, které 
budou na stránce u jednotlivých finančních instrumentů zobrazeny. Podrobně jsou všechny volby 
nastavení Layout popsány v kapitole „6. Vlastní nastavení zobrazovaných informací“. Nyní alespoň 
zmiňme, že volbou Clear Zero Position Rows můžete vymazat všechny sledované finanční 
instrumenty na konkrétní stránce. Pokud potřebujete vytvořit novou záložku, pak použijte tlačítko + 
dostupné na konci lišty se záložkami. 

 

 

 

 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

12 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

5 Praktická ukázka – příprava nové záložky s vlastní komoditou 

Pojďme si nyní připravit základní prostředí programu tak, aby vyhovovalo našim potřebám. Řekněme, 
že jsme intradenní obchodníci obchodující trhy E-mini Dow Jones (YM) a E-mini S&P (ES). 

Jako první vymažeme všechny záložky, které se na hlavní stránce zobrazily (kromě záložky Pending 
sloužící k zobrazování zadávaných obchodních příkazů). Záložku vymažeme tak, že myší najedeme na 
jméno záložky, klikneme pravým tlačítkem myši a zvolíme položku Delete. 

Pomocí + a volby Quote Monitor… na konci lišty se záložkami vytvoříme novou záložku, kterou si 
pojmenujme Komodity (jméno záložky zadejte do políčka Name okna Page Settings). Naše pracovní 
plocha by měla vypadat podobně jako na obr. 5.2. 

 

Obr. 5.1 – novou záložku pro přidání instrumentů přidáte kliknutím na tlačítko + a 
výběrem položky Quote Monitor…  

 

Obr. 5.2 – naše nová pracovní plocha – zatím prázdná. Plocha obsahuje jednu nově 
vytvořenou záložku nazvanou Komodity 

http://www.financnik.cz/
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Nyní si do záložky vložíme ceny sledovaných trhů E-mini DJ a E-mini S&P. Postupně jeden po druhém. 
Najedeme na první řádek tabulky a klikneme opět pravým tlačítkem myši. Zobrazí se kontextové 
menu, kde druhá položka shora je volba Ticker. 

 

Obr. 5.3 – najedeme-li na řádek myší a klikneme-li pravým tlačítkem, zobrazí se 
kontextové menu. Přes volbu Ticker je do tabulky možné vložit nově sledovaný kontrakt 

Zobrazí se dialogové okno Request Ticker by Underlying (žádost o kvóty podle podkladového aktiva), 
kde do políčka Underlying (podkladové aktivum) vložte symbol hledané komodity. Pro trh E-mini DJ 
vložte do políčka symbol YM. Na stránkách IB si můžete příslušný symbol vyhledat například pomocí 
funkce menu Trading > Product Listings. Mezi intradenními obchodníky jsou patrně nejznámější 
symboly – ES (E-mini S&P 500), YM (E-mini Down Jones), TF (E-mini Russell 2000), ZB (30-leté T-
bonds), NQ (E-mini Nasdaq 100). 

 

Obr. 5.4 – do okna Request Ticker by Underlying vložte symbol hledané komodity 

Po odkliknutí OK nám program nabídne výběr konkrétního kontraktního měsíce. Z rozbalovacího 
menu zvolíme Futures (jde nám o futures kontrakt – pokud bychom hledali například opci, z menu 
zvolíme Futures Options) a vybereme aktuálně obchodovaný kontraktní měsíc. 

http://www.financnik.cz/
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Obr. 5.5 – ticker přidáme do platformy tak, že vybereme požadovaný kontraktní měsíc 

Platforma se vás zeptá, zdali chcete přidat také podkladové instrumenty pro vybrané futures. Nás 
zajímá pouze futures, klikneme tedy na No. 

 

Obr. 5.6 – volbu je potřeba potvrdit kliknutím na No. V opačném případě se přidá také 
podkladový akciový index  

Pokud vše proběhne jak má, je výsledkem přidání cen pro futures kontrakt E-mini DJ (YM). Nyní si 
sami zkuste přidat druhý zmiňovaný trh – E-mini S&P, jehož zkratkou je ES tak, aby vaše okno 
vypadalo podobně, jako na obr. 5.6. 

 

Obr. 5.7 – IB platforma s přidanými kontrakty YM a ES 
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6 Vlastní nastavení zobrazovaných informací 

V předešlé kapitole jsme si ukázali, jak do základního okna platformy IB načíst libovolný kontrakt a 
naznačili jsme si, že celou stránku si můžeme do určité míry upravit podle vlastních potřeb. To je 
poměrně důležitá vlastnost, neboť řada sloupců v cenovém přehledu obsahuje informace pro akciové 
obchodování a ty důležité pro daytrading naopak chybí. Naštěstí není problém si obsah téměř každé 
stránky v IB platformě upravit, byť postup může na první pohled vypadat složitě. 

Layout 

Obsah každé stránky je řízen nastavením proměnné, které se říká Layout (česky by se výraz dal 
přeložit jako šablona zobrazení). Šablon zobrazení lze v systému definovat celou řadu, přičemž 
jednotlivým stránkám se pak přiřazuje konkrétní layout a podle toho jsou informace na stránce 
zobrazovány. 

Zkuste si schválně najet na aktuální nastavení aktuální stránky pomocí funkce Settings.  

 

Obr. 6.1 – kliknutím pravým tlačítkem na název záložky s vašimi instrumenty vyvoláte 
nabídku, ve které naleznete položku Settings 

Patrně získáte podobnou obrazovku, jako je na následujícím screenshotu: 
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Obr. 6.2 – obrazovka globálního nastavení. Zde naleznete prakticky veškerá nastavení 
platformy. Zde máme zobrazeno nastavení pro Quote Panel s názvem Komodity 
zobrazující naše přidané trhy 

Všimněte si hodnoty v políčku Layout – je zde uvedena hodnota Default. Znamená to, že struktura 
této konkrétní stránky se řídí nastavením Layoutu s názvem Default (výchozí). Layouty lze snadno 
konfigurovat v Layout Manager. Ten v TWS najdeme v menu jako položku Other Layouts. 

 

Obr. 6.3 – nástroj pro konfiguraci layoutů. Můžete si zvolit z existujících (ScaleTrader 
Layout, Volatility Layout, … atd.) nebo můžete vytvořit nový tlačítkem New 

Kliknutím na tlačítko New jsme si vytvořili nový layout a pojmenovali si jej Daytrading. Nový layout se 
nám zařadil mezi Other layouts. 

Nyní si ukážeme, jak si takový layout přizpůsobit podle svých představ. Klikneme tady na tlačítko Edit. 
Stejně tak můžeme kliknout ve stromové struktuře nastavení položku Daytrading (tam kde ukazuje 
šipka na obr. 6.3). Získáme přístup k následujícímu nastavení: 
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Obr. 6.4 – možnosti nastavení layoutu 

Po otevření Layout Editor vidíme, že máme k dispozici poměrně hodně políček, které lze měnit a 
definovat. Všimněte si, že v záhlaví jsou tři záložky – Market Data Columns, Oder Columns a Colors. 
Položce Market Data Columns (sloupce dat z trhů) se budeme věnovat v následujících odstavcích, 
Order Columns slouží upravení sloupců druhého řádku záhlaví (sloupce příkazové časti). Záložka 
Colors umožňuje změnit barevnost zobrazovaných čísel (každý si může vyzkoušet, ale položky není 
důvod měnit). 

Sloupec Shown Columns zobrazuje položky (názvy sloupců), které jsou aktivně zobrazené v hlavním 
okně s vybranými instrumenty. Momentálně máme tedy zobrazeny následující sloupce: Contract 
(název instrumentu), Last (poslední cena), Change (změna ceny), Change (%) (změna ceny v %), Bid 
Size (objem limit příkazů na ceně Bid), Bid (cena Bid), Ask (cena Ask), Ask Size (objem limit příkazů na 
ceně Ask), Position (směr otevřené pozice), Avg Price (vstupní cena), P&L (aktuální zisk/ztráta 
pozice). Tlačítkem Remove můžete vybrané aktivní sloupce odstranit a tlačítkem Add můžete naopak 
ze seznamu vpravo vybrat nové sloupce, které chcete v platformě zobrazit. 

Pozn.: pokud chcete vložit další oddělovače skupiny sloupcům, které rozdělí skupiny barevně, klikněte 
na tlačítko Sort, vyberte <3 point Separator ze seznamu a klikněte na tlačítko Add. 
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Obr. 6.5 – vložení barveného oddělení skupiny sloupců. Dva oddělovače jsou již vloženy 
ve výchozím nastavení 

Zaškrtnutí položky Fit columns to window znamená, že program automaticky upraví šířku 
jednotlivých sloupců tak, aby se vše vešlo na obrazovku. 

V následující tabulce je uveden stručný popis jednotlivých voleb okna Available Columns. Na vše se 
díváme z pohledu intradenního obchodníka, tj. stručně vysvětleny jsou pouze políčka, která jsou v 
rámci ID obchodování používána. Tučně jsou označeny ty položky, které jsou z našeho pohledu pro 
intradenní obchodování využitelné. Netučné položky doporučujeme z přehledu vypustit. 

Underlying – podkladové aktivum. Symbol kontraktu (např. ES pro E-mini S&P). Vždy se zobrazuje. 
Symbol Plné označení včetně kontraktního měsíce (např. ESZ1 pro prosincový kontrakt E-mini S&P). 

Exchange – označení komoditní burzy (např. GLOBEX). Není nutné zobrazovat, ale může pomoci v 
orientaci.  

Description – podrobný popis kontraktu (např. DEC11 Futures ESZ1). V případě daytradingu zbytečně 
zabírá místo. 

Position – pozice v daném kontraktu. Kladné číslo znamená, že jsme dlouzí uvedeným počtem 
kontraktu, záporné číslo znamená, že jsme krátcí uvedeným počtem kontraktů.  

P&L – otevřený zisk/ztráta v daném trhu za daný den. 

Unrealized P&L – složitější výpočet zisku a ztrát použitelný zejména pro akcie a opce. 

Bid Size – přibližná velikost poptávky. 
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Bid Price – nejlepší aktuální Bid cena – jde o nejlepší cenu, za kterou by bylo možné v tuto chvíli 
teoreticky prodat. 

Ask Price – nejlepší aktuální Ask cena – jde o nejlepší cenu, za kterou by bylo možné v tuto chvíli 
teoreticky nakoupit 

Ask Size – přibližná velikost nabídky 

Last Price – poslední cena, za kterou proběhlo zobchodování kontraktu 

Change – hodnota změny aktuální ceny oproti close předcházejícího dne 

Change (%) – procentně vyjádřená změna hodnoty ceny oproti close předcházejícího dne 

Last Size – velikost naposledy obchodovaného kontraktu 

High – maximum aktuálního dne 

Low – minimum aktuálního dne 

Volume – počet zobchodovaných kontraktů 

Close – uzavírací cena předcházejícího dne 

Nyní tedy máme připravenou šablonu Daytrading, kterou musíme aplikovat na příslušné stránky. To 
se provede velmi snadno – kliknutím pravým tlačítkem na název záložky s vašimi instrumenty 
vyvoláte nabídku, ve které naleznete položku Settings. Jako layout vyberte namísto hodnoty Default 
hodnotu Daytrading. 

 

Obr. 6.6 – layout změníme jednoduše v nastavení výběrem vytvořeného layoutu. Pokud 
několika stránkám přiřadíte stejnou šablonu, pak se při změně šablony samozřejmě 
změní vzhled všech stránek najednou 
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7 První jednoduchý obchod v IB platformě 

Platforma IB Trader Workstation je zde především pro obchodování. A obchody lze v této platformě 
zadávat hned mnoha způsoby – jak z hlavního okna programu, tak přes specializované dialogy, 
jednoduchým kliknutím, případně přes sofistikované formuláře, ale samozřejmě také přímo z grafu. 
Je to dáno faktem, že IB Trader Workstation je veskrze univerzální nástroj umožňující obchodovat 
nejen s komoditami, ale i s akciemi, warranty, opcemi a dalšími finančními instrumenty. Nicméně 
hned na začátku si řekněme, že přílišná univerzalita je do jisté míry na škodu. Zejména u intradenního 
obchodování, kdy se obchodník potřebuje maximálně soustředit na samotné obchody a není čas 
přemýšlet nad funkcemi obchodní platformy. Proto si zde sice popíšeme přístupy, jak futures přes IB 
Trader Workstation obchodovat, nicméně v závěru publikace si představíme další programy, které lze 
na IB platformu napojit a obchodování je s nimi výrazně pohodlnější. Principy obchodování v samotné 
platformě IB Trader Workstation si zde tedy ukazujeme především proto, že by každý obchodník měl 
alespoň do jisté míry chápat možnosti nástroje, který plně ovládá jeho účet. Na začátek si v této 
kapitole ukažme ten úplně nejjednodušší způsob, jak přes IB platformu obchodovat, i když tímto 
způsobem zcela jistě daytrading provádět nebudeme. Nicméně principy, které si ukážeme nyní, jsou 
aplikovatelné i v dalších příkladech zadávání příkazů a vhodně demonstrují princip práce s 
platformou. 

Ujistěte se, že pracujete v demoverzi programu! Nezkoušejte operace s nákupem a prodejem 
komodit na ostrém účtu, kde byste přicházeli o reálné peníze! 

Zadání příkazu 

Nyní si například řekněme, že chceme nakoupit 1 kontrakt ES za aktuální cenu. V takovém případě 
stačí kliknout levým tlačítkem myši na cenu ve sloupci Ask Price (na obr. 7.1 je zobrazeno 1307.75). 
Tím se do platformy zadá nákupní příkaz. Po kliknutí se na obrazovce objeví nový řádek pro potvrzení 
vloženého příkazu: 

 

Obr. 7.1 – kliknutím na cenu Ask, zadáme nákupní příkaz. Ten je potřeba ještě potvrdit 
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Obr. 7.2 – kliknutím na tlačítko Transmit potvrdíme příkaz a odešleme jej na burzu 

Výchozí nastavení platformy je takové, že každý zadávaný příkaz je potřeba potvrdit. Po stisknutí 
tlačítka Transmit tedy vyskočí okno s detailními informacemi o našem příkazu a s možností potvrzení. 
Pokud tedy znovu klikneme na tlačítko Transmit, náš příkaz se odešle. 

 

Obr. 7.3 – definitivní potvrzení příkazu. Pokud chcete tento dialog již více nezobrazovat, 
zatrhněte políčko Don’t display this message again 

 

Obr. 7.4 – do platformy jsme zadali dva příkazy. Jeden byl vyplněn ihned a druhý nákupní 
limitní příkaz čeká na vyplnění za cenu 1301.75  
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Nově vložený řádek vypadá na první pohled chaoticky, ale pouze do momentu, než se zaměříte na 
záhlaví tabulky (šedivá plocha). Všimněte si, že každý sloupec má v záhlaví nadepsány dva řádky. 
Horní řádek se přitom vztahuje k zobrazovaným cenám, spodní řádek k obchodním příkazům. Pak již 
dokážeme snadno rozpoznat, že zobrazený příkaz má následující parametry:  

Action (akce) má hodnotu BUY (nákup), Quantity = 1 (objem pozice činí 1 kontrakt), Type = LMT (typ 
příkazu je nastaven na Limit), Lmt Price = 1301.75. Jinými slovy – do trhu máme připravený limitní 
nákupní příkaz LMT BUY 1@ES 1301.75. 

Zrušení příkazu 

Nyní trochu odbočme a řekněme si, jak případně čekající příkaz zrušit. Jde to velmi snadno – na řádek 
s příkazem stačí najet a stisknout pravé tlačítko myši. Zobrazí se kontextové menu, ve kterém stačí 
zvolit volbu Cancel. Když už máme kontextové menu zobrazené – zajímavá funkce je Check Margin, 
kterou můžete před odesláním příkazu zkontrolovat, jak velký margin bude IB požadovat. Opět ale 
nejde o funkci, kterou bychom využívali v rámci daytradingu.  

 

Obr. 7.5 – pro zrušení limitního příkazu se nám nabízí několik možností. Příkaz můžeme 
zrušit z nabídky vyvolané kliknutím pravým tlačítkem na řádek se zadaným příkazem a 
poté kliknutím na Cancel, žlutým tlačítkem Cancel, nebo klávesou Delete 

Změna příkazu 

Před potvrzením lze příkaz nejen zrušit, ale také změnit. Jde to provést přes volbu Modify > Order 
Ticket zobrazenou v kontextovém menu, ale tato cesta je skutečně hodně pomalá. Rychlé drobné 
změny lze provádět nicméně přímo v řádku příkazu. Stačí kliknout na typ příkazu a změnit jej např. 
z LMT (Limit) na MKT (Market). Kliknutím na políčko Quantity můžeme změnit množství 
nakupovaných jednotek, kliknutím na bílé políčko s limitní cenou můžeme tuto cenu upravit. 
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Obr. 7.6 – zadané limitní příkazy můžeme jednoduše upravit přímo na řádku 

Nyní si popišme situace, které nastanou po odsouhlasení přenosu příkazu na server IB (tedy po 
kliknutí na tlačítko Transmit). Jakmile je příkaz odeslán, čeká na serveru IB k vykonání. Takový příkaz 
poznáme v IB platformě snadno – políčko Status je výrazně zelené (příkaz je aktivní na burze) a ve 
vedlejším políčku máme k dispozici žluté tlačítko Cancel. I takový příkaz lze měnit (kliknutím na 
příslušné políčko), případně zrušit kliknutím na žluté políčko Cancel.  

Tip: Všechny příkazy čekající na exekuci je možné nalézt také v záložce Pending, což ale opět ocení 
opční, poziční nebo akcioví obchodníci, kteří mohou mít v trhu zadáno několik příkazů najednou. 

Na dalším obrázku č. 7.7 je vidět situace, kdy došlo k exekuci, vyplnění nákupního příkazu (tj. vstoupili 
jsme do dlouhé pozice). Quantity u příkazu obsahuje „0“ a políčko Status již není zelené, ale obsahuje 
číslici 1 potvrzující exekuci 1 kontraktu. Současně si všimněte, že v řádku u instrumentu ES vidíme v 
políčku Position číslici „1“ značící, že máme otevřenou jednu dlouhou pozici. Řádek s exekuovaným 
příkazem za chvíli zmizí. Časový interval, jak dlouho je vyplněný příkaz zobrazován, lze nastavit v 
menu Configure > Orders > Leave filled orders on green for … seconds. Standardně je nastaven 
interval 30 vteřin. 

 

 

Obr. 7.7 – situace po exekuci příkazu. Nákupní příkaz byl vyplněn a systém zobrazuje 
jednu dlouhou otevřenou pozici v kontraktu ES 

Po uplynutí příslušného časového intervalu vyplněný příkaz zmizí. Pouze číslice 1 v poli Position u 
kontraktu ES signalizuje, že máme otevřenu jednu dlouhou pozici. 
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Obr. 7.8 – jediné upozornění na skutečnost, že máme v trhu otevřenou pozici, je číslice 1 
ve sloupci Position u kontraktu ES, tedy 1 kontrakt v dlouhé pozici 

Uzavření pozice 

Uzavření pozice probíhá stejně jako její otevření. Nicméně ukážeme si hned několik variant. V prvé 
řadě je možné dlouhou pozici uzavřít prodejem kontraktu (tzn. příkazem Sell). V takovém případě 
bychom klikli na cenu Bid a kontrakt prodali příkazem typu Market nebo Limit. Druhou možností je 
použití kontextového menu, které se zobrazí po kliknutí pravým tlačítkem myši na název kontraktu – 
viz následující screenshoty. 

 

Obr. 7.9 – kontextové menu, které se zobrazí po kliknutí pravým tlačítkem myši na 
označení kontraktu 

V tomto kontextovém menu můžeme kliknout na volbu Close Position (uzavřít pozici). Tato funkce je 
v daytradingu velmi důležitá a oblíbená. Bez přemýšlení vám v případě jakýchkoliv zmatků pozici 
automaticky uzavře bez rizika, že si spletete nákupní příkaz s prodejním či zadáte špatně počet 
kontraktů. Funkce automaticky vytvoří takový příkaz, který uzavře všechny pozice v daném trhu. Také 
tento příkaz je zde třeba potvrdit kliknutím na tlačítko Transmit, čímž dojde k jeho přenosu na server 
IB a k následné exekuci. 

Smyslem popisu uvedeného v této kapitole bylo nastínit základní principy práce s příkazy v prostředí 
IB platformy. Je zřejmé, že uvedeným způsobem by byl jakýkoliv daytrading naprosto neefektivní, 
přednastavené hodnoty nejsou vždy vhodné a ovládání velmi pomalé. Nicméně nyní již víte, jak v 
prostředí platformy poznáte otevřené pozice a jak případně takové pozice rychle uzavřít. Další 
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informace týkající se intradenního obchodování pomocí IB platformy naleznete v následujících 
kapitolách. 
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8 Book Trader – nástroj intradenních obchodníků 

Nástroj, se kterým lze v prostředí IB provádět asi nejlépe rychlé intradenní obchody, se nazývá Book 
Trader. V této kapitole se podíváme na postupy, jak pomocí tohoto nástroje nejen obchodovat s 
jednoduchými příkazy, ale také na to, jak si nastavit automatické příkazy stop-loss. Pokud vám 
popisované postupy přijdou složité, pak nezoufejte – i z tohoto důvodu sami používáme pro 
obchodování některý z frontendů popisovaných na konci této publikace. Pro upřesnění dodejme, že 
IB má k dispozici podobný nástroj jako Book Trader, který se jmenuje Market Depth. Tento nástroj v 
podstatě disponuje pouze trochu jiným layoutem a nabízí hodně podobné funkce a ovládání jako 
Book Trader, také nastavování je velmi podobné, a proto se v této publikaci budeme podrobněji 
věnovat pouze nástroji Book Trader. 

 

Obr. 8.1 – možností, jak spustit Book Trader je více. Buď pomocí kontextového menu 
případně tlačítka z hlavního menu 
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Obr. 8.2 – okno Book Trader s vybraným instrumentem. Hloubka trhu je zde omezena 
pouze na jednu úroveň jelikož se jedná o demo účet 

Book Trader obsahuje na malé ploše poměrně dost informací, což může působit na první pohled 
hodně nepřehledně, ale uvidíte, že po určitém čase se naučíte vnímat nejrůznější barevné kódy a 
práce v tomto programu se stane rutinou (pokud nebudete používat nějaký jiný nástroj pro zadávání 
příkazů jako třeba NinjaTrader zmiňovaný také v této publikaci). 

Tabulka s přehledem poptávky Bid/Ask  

Největší část plochy Book Trader zabírá okno s přehledem množství aktuální nabídky a poptávky po 
dané komoditě. Tomuto přehledu se běžně říká market depth (případně Depth of Market) a i my 
budeme v této publikaci toto označení používat. Prosím rozlišujte, že v IB platformě existuje i 
samostatný nástroj Market Depth, kterému se však v publikaci nevěnujeme. Kdykoliv se tedy v 
následujícím textu odvoláváme na market depth (s malými písmeny), máme na mysli spodní oblast 
okna Book Trader. Okno obsahuje několik sloupců (obr. 8.2) – Status, Size, Bid Size, Price, Ask Size, 
Size, Status. 
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Sloupce nalevo od Price, tj. na našem screenshotu levý sloupec Status a žlutý sloupec Bid Size, se 
vztahují k ceně Bid a vždy k nákupním operacím. 

Sloupce napravo od Price, tj. na našem screenshotu pravý sloupec Status a zelený sloupec Ask Size, se 
vztahují k ceně Ask a vždy k prodejním operacím. Zní to možná trochu složitě, ale praxe je 
jednoduchá – pokud klikneme na příslušnou hodnotu v zeleném sloupci (Ask Size), vytvoří se nám 
prodejní příkaz Sell (reflektující hodnotu řádku, na který klikneme). A analogicky, pokud klikneme na 
příslušnou hodnotu v žlutém sloupci (Bid Size), vytvoří se nám nákupní příkaz Buy (reflektující 
hodnotu řádku, na který klikneme). 

Jednotlivé sloupce market depth 

 

Obr. 8.3 – tabulka market depth nástroje Book Trader 

Nyní se pojďme podrobněji podívat na to, co všechna ta čísla znamenají. V prostředním sloupci 
nazvaném Price je zobrazena stupnice reflektující aktuální cenu instrumentu, plus se od této ceny 
odvíjí i několik okolních cen. Aktuální cena je zobrazena na tmavomodrém pozadí (formát 
1@1309.25). Jde o cenu Last, tedy cenu, za kterou byl uskutečněn na burze poslední obchod. Na obr. 
8.3 má aktuální cena hodnotu 1309.25. Současně můžete vidět ve sloupci Price ještě další barvy (ne 
všechny barvy jsou na aktuálním screenshotu zobrazeny): 

žlutá barva – znamená aktuální nejlepší Bid cenu (na obrázku hodnota 10460) 

zelená barva – znamená aktuální nejlepší Ask cenu 

sytě modrá barva – High daného dne (tedy nejvyšší obchodovaná cena daného dne) 

červená barva – Low daného dne (tedy nejnižší obchodovaná cena daného dne)c) www.financnik.cz 

Ve sloupcích Bid Size a Ask Size pak vidíme čísla vyjadřující zájem obchodníků nakupovat (Bid) nebo 
prodávat (Ask) za danou cenu.  
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K čemu jsou hodnoty Bid Size a Ask Size dobré, je předmětem samotné obchodní strategie. 
Principiálně je dobré vědět, že trh má likviditu – pokud jsou v sloupcích Bid Size a Ask Size rozumné 
hodnoty, je vidět, že obchodníci prodávají a nakupují a trh se může svižně hýbat. Orderflow 
obchodníci mohou z hodnot vycítit i určitou převahu poptávky nad nabídkou a podobně, ale tyto 
přístupy již vyžadují praxi a cvik. 
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9 Obchodování pomocí market depth oblasti 

Princip samotného obchodování je podobný tomu, který jsme si popisovali v předcházející kapitole – 
stačí kliknout do tabulky na místo příslušné ceny a Book Trader vytvoří nákupní (klikáme do sloupce 
Bid Size) nebo prodejní (klikáme do sloupce Ask Size) příkaz. 

Vše je dobře vidět na následujícím screenshotu: 

 

Obr. 9.1 – do trhu jsme zadali příkaz Sell Limit 1 kontraktu ES za cenu 1311.00. Trh se 
momentálně nachází 1,5 ticku níže 

Na obr. 9.1 je zobrazena situace, kdy aktuální cena komodity ES na trhu je 1309.50. My jsme chtěli 
zadat prodejní příkaz („“l) tak, aby nejhorší cena plnění byla 1311.00. Klikneme proto do sloupce Ask 
Size na řádek korespondující s cenou 1311.00. Platforma vytvořila příkaz SELL 1 ES 1311.00 LIMIT a 
tento příkaz čeká na exekuci. Všimněte si, že příkaz je vidět v tabulce Orders, kde je možné jej zrušit 
kliknutím na tlačítko Cancel na žlutém pozadí. V samotném okně market depth příkaz vidíme v 
podobě barevných políček. Zelené políčko ve sloupci status znamená, že příkaz byl akceptován a čeká 
na vyplnění. Políčko Status může mít ještě několik dalších stavů = barev, které však již nejsou pro 
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intradenní obchodování tak časté a jejich význam si můžete vyhledat v nápovědě pod heslem „Book 
Trader Colors“. 

Konfigurace oblasti market depth 

 

Obr. 9.2 – konfigurace nástroje Book Trader 

Oblast market depth si můžeme také do určité míry nastavit podle našich potřeb stejně jako skoro 
každé libovolné okno IB platformy. Mimo jiné lze měnit počet řádků zobrazovaných v oblasti market 
depth (na screenshotech je počet řádků nastaven na hodnotu 10). Konfigurace probíhá přes volbu 
Configure > Trading Tools > Book Trader. 

Samotné konfigurační okno obsahuje pouze několik položek, z nichž patrně nejdůležitější je Number 
of rows to display umožňující změnit počet zobrazených řádků. Standardní počet 40 je poměrně dost 
a dělá okno zbytečně nepřehledným. Hodnotu doporučujeme změnit na 10 – 20. 

Rozhraní disponuje mnoha rozmanitými nastaveními. V další části Hotkeys je například možné 
nadefinovat klávesové zkratky pro rychlé zadávání příkazů, což mohou ocenit rychlí intradenní 
obchodníci. 
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Předdefinování příkazových šablon 

Pomalu se začínáme dostávat do oblastí definování vlastních typů příkazů, což je v IB platformě 
trochu těžkopádné a pro netechnicky orientované obchodníky nesnadno pochopitelné. Navíc bohužel 
ne vše je možné. Tuto kapitolu se proto budeme snažit maximálně zjednodušit a nastínit zde opravdu 
pouze ty nejzákladnější principy. Jako v celé TWS platformě i zde narazíte na stovky možných 
nastavení – nenechte se tím však odradit. Vše je opět přizpůsobeno maximální univerzálnosti 
programu. Pro intradenní obchodování vám bude stačit nadefinovat tři, čtyři „horké klávesy“ a další 
nastavení vás nemusí zajímat. 

A co že vlastně chceme přednastavit? Intradenní obchodování je převážně o rychlé reakci na vstupní 
a výstupní signály. V likvidních trzích může několik vteřin znamenat posun cen o velkou dolarovou 
částku a při takovém obchodování je třeba maximální automatizace. Obchodníci si tak řadu operací 
automatizují např. na jedno kliknutí myší nebo stisknutí jednoho tlačítka. Může jít například o 
automatické zadávání stop-loss příkazů jakmile dojde k exekuci, nebo zavření všech pozic po stisknutí 
„horké klávesy“. Konkrétní nastavení všech automatických akcí se v Book Traderu provádí přes volbu 
Configure > Hotkeys... (každá akce v prostředí Book Traderu, včetně kliknutí myši, je označováno jako 
práce s „hotkey“). Zobrazí se okno podobné tomu na našem následujícím screenshotu: 

 

Obr. 9.3 – konfigurace činností v prostředí Book Traderu 

Byť na vás okno díky počtu nejrůznějších výrazů působí jistě přinejmenším složitě, práce s tímto 
nástrojem není až tak komplikovaná. Stačí si uvědomit, jaké informace zde jsou zobrazeny. Horní 
okno nadepsané Possible Actions zobrazuje naprosto všechny úkony, které je možné automatizovat 
napojením na stisknutí nějaké klávesy (případně kombinací kláves) nebo kliknutí myši. Je zde 
uvedeno mnoho pojmů včetně „zobrazení grafu“, „zobrazení stavu účtu“ atd., proto je seznam tak 
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dlouhý. V dolním okně Configured Shortcuts vidíme aktuálně nadefinované automatizované zkratky 
(akce spouštěné jak přes stisknutí kláves, tak přes kliknutí myší). Sami vidíte, že jako první dvě zkratky 
jsou na našem screenshotu akce Buy a Sell. Tyto dvě zkratky mají prázdná políčka ve sloupci Key (tj. 
není jim přiřazená žádná klávesa, která by tyto akce aktivovala), ale ve sloupci Mouse (myš) vidíme, 
že Buy má přiřazeno Left Click on Ask Price (kliknutí levým tlačítkem na cenu Ask) a Sell má přiřazeno 
Left Click on Bid Price (kliknutí levým tlačítkem na cenu Bid). A to jsou přesně operace, které jsme v IB 
platformě již prováděli. Pokud bychom takovou akci chtěli změnit (např. připojit automatický stop-
loss), stačí, když ji upravíme přes tlačítko Configure. 

Pozor! Řadu krušných chvil a otázek typu „Proč to nefunguje“ si ušetříte, pokud věnujete pozornost 
tomuto odstavci. Na výše uvedeném obrázku 9.3 si všimněte, že IB platforma rozlišuje na první 
pohled dost podobné pojmy Ask a Ask Size. Pokud použijete tyto pojmy jako místo pro aktivaci akce 
(tj. místo, kam se má kliknout myší), všimněte si na následujícím obrázku, co má IB těmito pojmy na 
mysli! Ask znamená políčko v oblasti Quote Panel, zatímco Ask Size značí zelený pruh v tabulce Book 
Trader. Definujete-li akci s použitím políčka Ask, vždy pak musíte klikat do políčka Quote Panel. 
Mimochodem – takto definovaná akce bude fungovat kdekoliv v celé IB platformě (tj. i v hlavním 
panelu s přehledem cen), kde se nachází políčko Ask. Chcete-li akci definovat pro zelenou oblast v 
panelu Book Trader, je třeba použít hodnotu Ask Size. 

 

Obr. 9.4 – jednotlivé oblasti nástroje Book Trader jsou pojmenované podobně. Všimněte 
si konkrétních rozdílů 
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Jistě tušíte, že akci můžeme změnit tak, že najedeme na příslušný řádek a klikneme na tlačítko 
Configure. Řekněme, že v následujícím příkladu upravíme operaci Left Click on Ask Price tak, abychom 
současně s nákupem komodity zadali do trhu také stop-loss příkaz a příkaz typu profit target. 
V nastavení Hotkeys si označíme tedy první řádek Buy a klikneme na tlačítko Configure. Zobrazí se 
konfigurační okno složené ze dvou záložek. 

 

Obr. 9.5 - v nastavení Hotkeys si označíme tedy první řádek „Buy“ a klikneme na tlačítko 
Configure. Zobrazí se konfigurační okno složené ze dvou záložek 

 

Obr. 9.6 – v záložce je možné změnit klávesy a operací myší, na které je akce v druhé 
záložce Customize vázána 

V první záložce Shortcuts si můžeme nadefinovat, jaká operace spustí danou akci. Pokud bychom 
chtěli přiradit akci nějaké klávesové zkratce, stačí kliknout na tlačítko Record a klávesovou zkratku 
uložit. Ve spodní části je možné přiřadit akci určité kombinaci kliknutí myší. My v tuto chvíli editujeme 
již stávající zkratku, takže operace je přiřazena kliknutí levým tlačítkem myši (Left Click) na příslušný 
řádek Ask size v tabulce Book Trader – Ask Size. Můžeme tedy přejít na druhou záložku s názvem 
Customize. 
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Obr. 9.7 – záložka Customize umožňuje nadefinovat parametry obchodních příkazů 

V části Order se definují parametry hlavního příkazu, v pravé části Attached Stop Order příkaz, který 
se automaticky zadá do systému v případě, že je vyplněn (exekuován) hlavní příkaz. Jako připojené 
příkazy se používají např. stop-lossy, profit-targety apod. 

Podstatná informace pro celé toto okno: Hodnota nastavená na „Default“ říká, že hodnota pro dané 
políčko bude převzata z globálního nastavení příkazů pro jednotlivé trhy, kterému se věnujeme v 
kapitole „10. Globální předdefinování obchodních příkazů“. Jde o to, že nastavení Book Traderu bude 
obchodník pravděpodobně chtít používat pro různé trhy. V těch by se program měl chovat stejně (tj. 
např. při kliknutí myši do určité oblasti vygeneruje nákupní příkaz včetně stoplossu), ale s různými 
parametry (v každém trhu chceme zadávat různé stop-lossy). Proto si s pomocí hodnoty „Default“ 
můžeme nadefinovat obecné parametry chování Book Traderu a s pomocí nastavení Order Defaults 
definovat jednotlivé hodnoty pro jednotlivé trhy. Jinými slovy – pokud bychom nyní v Book Trader 
vyplnili do určitého políčka např. hodnotu 2 body, bude program vždy pracovat s hodnotou 2 body v 
kterémkoliv trhu. Pokud však v políčku nastavíme hodnotu „Default“ a pomocí Order Defaults (bude 
probráno dále) nastavíme pro trh ES hodnotu 2 a pro trh YM např. hodnotu 3, pak bez jakéhokoliv 
dalšího nastavení bude Book Trader používat pro zmíněné trhy dané hodnoty. 

 

Obr. 9.8 - příkazy lze vázat na proměnné Book Trader Price, Bid a Ask 

Action – typ příkazu Buy/Sell 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

36 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

Size – množství kontraktů (pokud necháme prázdné, pracuje program s množstvím nastaveným v 
Order Defaults – doporučujeme nechat prázdné) 

Order Type – typ příkazu – MKT = Market, STP = Stop, LMT = Limit atd., podrobně se příkazům 
budeme věnovat dále v publikaci 

Lmt price – určuje, která cena je brána jako vstupní hodnota v případě použití limitního příkazu, do 
vedlejšího políčka je možné vložit hodnotu, o kterou bude limitní příkaz navýšen nebo snížen 

Stop Price – určuje, která cena je brána jako vstupní hodnota v případě použití stop příkazu, do 
vedlejšího políčka je možné vložit hodnotu, o kterou bude stop příkaz navýšen nebo snížen 

Trailing amout – hodnota posouvaného stop-lossu. V případě hlavního příkazu nemá pole význam  

Offset Amout – opět nemá význam pro intradenní strategie 

TIF – platnost příkazu – doporučujeme nechat nastaveno Default 

Doporučené nastavení: Pro oblast Order doporkosučujeme pouze nastavit typ příkazu (Buy, Sell) a 
Order type nechat na „Default“. Do políček Lmt price a Stop price vyplnit Book Trader Price (pokud 
chcete příkazy zadávat kliknutím do tabulky Book Trader). Ostatní políčka nevyplňovat, pokud 
nevytváříte specifickou strategii a nevíte přesně, co děláte. 

Jak si můžete na screenshotech všimnout, u parametrů příkazů se vybírá navíc z hodnot označených 
jako Ask, Bid a Book Trader Price. Na obrázku 9.8 můžete vidět řádek definující stop příkaz – Stop 
price (+/- offset) a výběr z pěti položek. Tento výběr slouží pouze k určení, jaká cena bude v příkazu 
použita – Bid znamená aktuální cena Bid, Ask znamená aktuální cena Ask, Book Trader Price 
znamená cena, na kterou klikneme v tabulce Book Trader (obr. 9.4), None znamená, že příkaz nebude 
aktivní a Default znamená, že bude použito výchozí nastavení. Do políčka vedle výběru se pak nastavuje 
posun hodnoty v příkazu od aktuální ceny. Pokud tedy do řádku Stop price (+/- offset) nastavíme 
Book Trader price a do políčka vedle vyplníme číslo „6“. Znamená to, že po kliknutí do tabulky Book 
Trader bude vygenerován stop příkaz s cenou podle řádku, na který jsme kliknuli plus 6 bodů. 

Pozor na znaménka! Zadáváme-li automaticky generovaný příkaz pod vstupní hodnotu, je třeba jej 
zadávat jako záporné číslo – viz příklad popisovaný na konci této kapitoly. 

Attached Stop Order 

Z pohledu intradenního obchodování můžeme pomocí této funkce vytvořit následující automatické 
typy příkazů: 

Stop-loss – hodnota Order Type se nastaví na Stop. Tato funkce vytvoří automatický příkaz typu STOP 
do specifikované vzdálenosti od vstupu do trhu. Příkaz se automaticky neposouvá a v trhu zůstává do 
svého zrušení (nebo vyplnění). V tomto případě vyplňujeme Stop Type (chceme-li mít stop-loss 
zadaný jako čistý stop nebo jako stop-limit) a políčka Stop price (zde vyplňujeme, s jakou cenou 
pracujeme – Bid/Ask nebo Book Trader Price), případně parametry pro Stop limit. 
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Automaticky posouvaný stop-loss – hodnota Order Type se nastaví na Trailing Stop. Tato funkce 
automaticky vytvoří příkaz typu STOP do specifikované vzdálenosti od vstupu do trhu, který se však 
automaticky posouvá o hodnotu zadanou v políčku Trailing amout (zadává se hodnota v bodech). 
Nastavení ostatních parametrů platí jako u stop-lossu. Pozor – IB vysloveně varuje před používáním 
automatického trailing stopu, který může být ve volatilních trzích velmi nespolehlivý a jeho funkci 
není podle IB možné garantovat. Také pozor na skutečnost, že příliš časté měnění jednoho příkazu 
(což je případ právě trailing stopu) může vést k dodatečnému zpoplatnění operace ze strany IB (viz 
jejich ceník). Trailing Stop lze připojit pouze k limitnímu příkazu. Obecně doporučujeme v 
intradenním obchodování posouvat stop-loss spíše ručně. 

Target Order (Profit-taker) 

Profit-target – hodnota Order Type se nastaví na Limit. Tato funkce vytvoří automaticky limitní příkaz 
vzdálený definovaný počet bodů od vstupu, sloužící jako profit-target – dosáhne-li trh definované 
vzdálenosti, pozice se automaticky uzavře a profit je připsán na účet. Vyplňujeme Limit price (zde 
vyplňujeme, s jakou cenou pracujeme coby vstupní hodnotou – Bid/Ask nebo Book Trader Price a 
vzdálenost v bodech). 

Zaškrtnutá položka Transmit the order instantaneously znamená, že automaticky vygenerované 
příkazy NEBUDOU vyžadovat žádné manuální potvrzení, ale budou okamžitě předávány k exekuci. 
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Konkrétní příklad nastavení 

Abychom si vše ukázali prakticky, vytvoříme si nyní jeden automatický příkaz společně. Naším cílem 
bude vytvořit prodejní limitní příkaz poté, co v okně Book Trader klikneme na příslušnou cenu v 
zeleném sloupci Ask Size. Automaticky s vytvořením prodejního limitního příkazu v trhu ES chceme 
vytvořit odpovídající stop-loss ve vzdálenosti 100 USD a současně profit target ve vzdálenosti 
150 USD od vstupu. Otevřeme si Book Trader pro kontrakt ES a zvolíme v menu Configure > 
Hotkeys... 

 

Obr. 9.9 – dialog pro definování automatizovaných akcí. Pro účely našeho příkladu pouze 
změníme nastavení již existující akce Left Click on Ask Size 

Vidíme, že v platformě již existuje určitá definice pro operaci Left Click on Ask Size – proto na tuto 
volbu najedeme myší a klikneme na tlačítko Configure. Přejdeme rovnou do záložky Customize, 
neboť definice naší operace (kliknutí levým tlačítkem myši na oblast Ask Size) zůstává nezměněná. 
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Obr. 9.10 – konkrétní nastavení konfiguračního okna pro akci, která vygeneruje prodejní 
limitní signál a současně po jeho exekuci automatický SL (vzdálený 2 body) a automatický 
PT (vzdálený 3 bodů od vstupu) 

Na screenshotu jsou barevně vyznačeny oblasti, které pro nastavení našeho příkazu musíme změnit. 
Jak jsme již zmínili, políčka s konkrétní hodnotou (-3.00 a 2.00) je lepší nechat prázdná a hodnoty 
zadat do globální konfigurace Order Defaults, které se věnujeme v následující kapitole. 

Pozor! V globálním nastavení Order Defaults IB umožňuje v aktuální verzi definovat pro jednotlivé 
trhy pouze jedinou proměnou, určující vzdálenost příkazu od vstupu společnou pro limitní i stop 
příkaz. Pokud tak obě políčka na screenshotu vyznačená zeleně necháte prázdná, IB je vyplní pro 
daný trh stejným číslem (tj. stop-loss pak bude vzdálen od vstupu stejně jako profit target). Chcete-li 
pracovat s profit-targetem odlišným od stop-lossu, je třeba číslo zapsat v konfiguraci Book Traderu 
„natvrdo“ stejně, jako jsme to udělali na našem screenshotu my (hodnota -3) – bohužel pak toto 
nastavení bude shodné pro všechny obchodované trhy. V případě, že obchodujete více trhů, se tak 
tato funkce dá použít prakticky pouze pro zadávání stop-loss příkazů (tj. bez profit-targetů). 

V sekci Order tedy nastavíme Action na Sell (chceme vytvořit prodejní příkaz), Order type na LMT 
(chceme vytvořit limitní příkaz) a Lmt price (+/- offset) na Book Trader Price (chceme vytvořit limitní 
příkaz s hodnotou podle řádku, na který klikneme v tabulce Book Trader). Ostatní políčka 
nevyplňujeme.  

V sekci Target Order (Profit-Taker) nastavíme Type na LMT. V řádku Lmt price (+/- offset) definujeme 
limitní příkaz, tedy náš profit-target. Příkaz chceme umístit do vzdálenosti -3 bodů od vstupu (tj. 150 
USD v ES trhu, minusová hodnota je zde proto, že spekulujeme na pokles ceny). Vyplníme tedy 
hodnotu „-3.00“. 

V sekci Attached Stop Order nadefinujeme Order Type na Stop. Použijeme obyčejný stop příkaz, 
proto hodnotu řádku nastavíme na Stop. Příkaz chceme umístit do vzdálenosti 2 body od vstupu (tj. 
100 USD v ES trhu), proto do políčka Stop price (+/-) vyplníme „2.00“. 
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Zatrhneme položku Trasmit the order instantaneuously – tím IB říkáme, že automaticky generované 
příkazy nebudeme ručně potvrzovat a příkazy budou zadány do trhu okamžitě, jakmile dojde k 
exekuci hlavního příkazu definovaného v sekci Order. Nastavení potvrdíme kliknutím na tlačítko 
Close, konfigurační okno zavřeme kliknutím na tlačítko OK. Jak takový automatizovaný příkaz 
funguje, si můžeme hned vyzkoušet kliknutím v Book Trader do oblasti Ask Size (nezapomeňte Book 
Trader aktivovat zaškrtnutím položky Armed). Vše zkoušejte nejdříve pouze v demoverzi programu! 

 

Obr. 9.11 – Book Trader se zadaným příkazem a dvěma automaticky vygenerovanými 
příkazy 

Na našem screenshotu vidíme, že akce funguje přesně tak, jak jsme si ji nadefinovali. V Book Trader 
jsme klikli do zeleného sloupce Ask Size na řádek s cenou 1295.75. Tím se vytvořili čekající prodejní 
(Sell) limitní příkaz s hodnotou 1295.75. Automaticky se vytvořily dva nákupní příkazy – limitní příkaz 
coby náš profit-target s cenou vzdálenou 3 bodů od vstupu. Tento limitní příkaz čeká v trhu na 
hodnotě 1292.75, a pokud cena klesne až na tuto hodnotu (a my vyděláme 150 dolarů), vystoupíme 
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automaticky z trhu. Druhý příkaz čekající v systému je náš stop-loss. Ten čeká na hodnotě 1297.75 – 
tedy 2 body od našeho vstupu. Pokud půjde trh špatným směrem a povyroste o 150 dolarů, 
vystoupíme s definovanou ztrátou právě na tomto bodě. Příkazy jsou do trhu nastavené jako 
podmíněné neboli tzv. OCO (One Cancels Others) – exekuce jednoho automaticky zruší druhý příkaz. 
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10 Pracujeme s Book Trader 

V předchozích kapitolách jsme si již mnoho z práce v prostředí Book Trader naznačili. Nyní se pojďme 
podívat na zbylé součásti tohoto nástroje. 

 

Obr. 10.1 – prostředí Book Trader. Jednotlivé oblasti A – G jsou popsány níže v této 
kapitole 

Popis vezměme tentokrát netradičně odspodu. Spodní okno market depth s cenami a velikostmi Bid a 
Ask (označeno jako A) jsme si již popsali v předcházející kapitole včetně způsobu, jak v tomto 
prostoru zadávat obchodní příkazy. Pojďme se podívat výše – do oblasti označené na screenshotu 
jako B. Tato oblast se vztahuje k zadaným i exekvovaným příkazům a skládá se hned z několika 
záložek. Záložka Orders obsahuje informace o příkazech čekajících na exekuci. Vyplněné příkazy ze 
záložky mizí. Sloupce, které jsou v této oblasti zobrazovány, lze nastavit v menu Configure > Order 
Columns. Pro účely intradenního obchodování stačí zobrazení základních „povinných“ sloupců, které 
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jsou v samotné konfiguraci zobrazeny tučně. Jednotlivé sloupce patrně nepotřebují překlad – Action 
(Buy nebo Sell), Quantity (počet příkazů), Type (typ příkazu – nejčastěji MKT – Market, LMT – limitní 
příkaz, STP – stop příkaz), Lmt. Price (cena zadaná u limitního příkazu), Aux. Price (cena zadaná u 
stop a stop-limit příkazu), Status (stav příkazu – barevné kódy vyjadřující stav příkazu – viz níže). 

Barevné kódy rozlišující stavy příkazu: 

 
Šedá označuje vytvářený příkaz, který ještě nebyl přenesen na IB server. 

 
Světle modrá označuje příkazy, které byly přeneseny na IB servery, ale zatím nebylo 
potvrzeno jejich přijetí. 

 

Zelená označuje přijatý příkaz, který je aktivní, přenesený na IB server a čekající na 
vyplnění. 

 

Purpurová označuje příkazy, které byly zrušeny, ale jejich zrušení nebylo dosud 
potvrzeno ze strany IB. Takový příkaz je stále aktivní a může dojít k exekuci. 

 

Červená barva označuje potvrzení zrušeného příkazu. Zrušený příkaz po 30 vteřinách 
zmizí z přehledu. 

 
Tmavě modrá barva znamená, že simulovaný příkaz čeká v systému na splnění 
podmínek. Jakmile dojde k splnění podmínek aktivace příkazu, změní se jeho barva. 

 

Kaštanová barva znamená, že připojený simulovaný příkaz čeká v systému, ale nebyl 
zatím předán dále. Jakmile dojde k splnění podmínek aktivace příkazu, změní se jeho 
barva. 

 
V záložce Orders je možné zobrazené příkazy také měnit. Stačí kliknout na příslušnou hodnotu a 
změnit ji podle našich představ. Zvyšování/snižování hodnoty lze nadefinovat také jako akci přes 
„horké tlačítko“, které poslouží pro akce Increase price or size (zvýšit cenu nebo množství), případně 
Decrease price or size (snížit cenu nebo množství). 

Záložka Log (Žurnál) obsahuje seznam operací, které byly prostřednictvím Book Traderu provedeny. V 
žurnálu je možné dohledat, v kolik hodin došlo přesně k zadání příkazu, v kolik byl příkaz vyplněn a za 
jakou cenu atd. 

V záložce Trades nalezneme informace o exekuovaných příkazech. Pozor – v rámci této záložky jsou v 
prostředí Book Trader uváděny pouze příkazy zadané právě a pouze prostřednictvím konkrétního 
okna Book Trader. Obecný přehled o všech exekucích najdete v podobném formátu v okně Trade Log 
dostupného z hlavního okna IB platformy (menu Account > Trade Log). Sloupce okna Executions lze 
měnit podle vlastních potřeb. Vše se v Book Trader nastavuje v globální konfiguraci v menu Trading 
Tools > Book Trader > Trade Columns... Mezi zobrazované sloupce doporučujeme zařadit i čas 
exekuce (políčko Time) a vypnout zobrazování sloupců, které neobsahují informace podstatné pro 
intradenní obchodování. Záložka pak může vypadat například následovně: 
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Obr. 10.2 – příklad přehledného uspořádání okna Trades informující o exekucích v daném 
okně Book Trader. Sloupce můžete libovolně přidávat a odebírat kliknutím pravým 
tlačítkem na kterýkoliv sloupec a zvolením Configure Trade Columns 

Jednotlivé sloupce vám jsou svým významem již jistě zřejmé. Action (SLD – prodaný kontrakt, SLD – 
prodaný kontrakt), Time (čas exekuce), Quantity (počet kontraktů), Underlying (značka 
podkladového aktiva – ES pro E-mini S&P), Price (cena, za kterou byl kontrakt prodán/nakoupen), 
Currency (měna, ve které byl kontrakt prodán/nakoupen), Exch. (burza, na které byl kontrakt 
prodán/nakoupen). 

V záložce Portfolio nalezneme otevřené kontrakty, ale pozor – opět jde pouze o kontrakty 
nakoupené přes aktuálně otevřený Book Trader. Všechny otevřené pozice (tj. ve všech trzích) jsou 
zobrazeny v sekci Portfolio, kterou naleznete pod funkcí Account (účet – podrobně se účtu věnujeme 
dále v samostatné kapitole). Záložka Portfolio nejde v aktuální verzi IB platformy nastavovat, v 
případě intradenního obchodování tak není příliš použitelná – informace o počtu kontraktů vidíme 
mnohem přehledněji v oddílu Quote Panel. 

 

Obr. 10.3 – tlačítko pro kontrolu pozice. Tlačítka můžete upravit např. kliknutím pravým 
tlačítkem na prázdnou plochu a zvolením Configure Buttons 

Oblast C obsahuje dvě tlačítka. Červené tlačítko Close Position slouží k okamžitému uzavření všech 
otevřených pozic v rámci daného trhu. Tato funkce je výborná pro případ, že přesně nevíme „co a 
jak“, případně kolik máme v trhu pozic a na které straně. Funkce Close Position nás v takovém 
případě bezpečně dostane z trhu. Je nicméně důležité věnovat pozornost několika zvláštnostem. 
Především vytvořený příkaz je nutné vždy manuálně potvrdit! Je tedy třeba kliknout na tlačítko 
Transmit u příslušného nově vytvořeného čekajícího příkazu. A současně je třeba ručně zrušit 
všechny čekající stop-loss a profit target příkazy, které byly automaticky nebo ručně vytvořeny k 
otevřeným pozicím! IB platforma tyto příkazy ručně bohužel nezruší, a pokud je necháte čekat v trhu, 
dříve nebo později se vytvoří nové pozice, o které rozhodně nemáme zájem. 

Tlačítko Reverse Position slouží k otočení otevřené pozice. Pokud jste vstoupili do trhu příkazem 
BUY, funkce uzavře aktuální pozici a okamžitě otevře příkazem Market short pozici. Funkce však 
neupravuje přidružené příkaz pro stop-loss a profit-target. Při otočení je tedy potřeba v části B 
upravit typ příkazů a v části A potom posunout příkazy na požadované ceny. 
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Tlačítko View Account slouží k otevření souhrnné informace o účtu. Podstatný je fakt, že teprve v 
okně Account vidíme souhrnné informace o všech trzích najednou. Podrobně se o okně Account 
zmiňujeme v samostatné kapitole. 

 

Obr. 10.4 – část D – Quote Panel, které zobrazuje základní informace o ceně komodity a 
případně informující o počtu kontraktů, které v trhu máme otevřené 

Tím se dostáváme do oblasti označené D - Quote panel. Jde o panel obsahující základní informace o 
ceně komodity a případně informující o počtu kontraktů, které v trhu máme otevřené a aktuálním 
profitu/ztrátě. Konkrétní zobrazené sloupce lze nastavit přes Configure > Quote Panel .... 
Podrobnému popisu jednotlivých položek jsme se věnovali v sekci „Vlastní nastavení zobrazovaných 
informací“. Zaškrtávací políčko Armed slouží k „aktivování“ platformy Book Trader. Jakmile je políčko 
zaškrtnuté, stačí jeden klik a dojde k zadání příkazu a jeho případné exekuci. 

 

Obr. 10.5 – výchozí nastavení velikosti otevíraných pozic 

Políčko Default size určuje počet kontraktů, se kterými obchodujeme. 

 

Obr. 10.6 – rychlý přístup k vybraným funkcím 

Oblast F obsahuje ikonky pro rychlý přístup k vybraným funkcím. Tlačítko Cancel All zruší všechny 
neexekuované, čekající příkazy. Tato volba je praktická v kombinaci s tlačítkem Close Position, které 
uzavře všechny otevřené pozice, ale čekající příkazy nechá v systému. Clear Log vymaže všechny 
záznamy v žurnálu, položka Re-center nastaví oblast s cenami tak, aby aktuální cena byla uprostřed 
obrazovky. Tlačítko Configure představuje pouze rychlejší cestu do konfigurace Book Traderu. 

 

Obr. 10.7 – hlavní menu Book Trader 

Oblast G je samotné menu, jehož nastavování jsme si podrobně popsali v rámci této a předchozí 
kapitoly. 

 

 

 

 

 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

46 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

Globální předdefinování obchodních příkazů 

V kapitole týkající se práce v Book Trader jsme si řekli, že IB platforma umožňuje předdefinovat 
parametry obchodních příkazů podle jednotlivých trhů. Nyní se pojďme podívat jak konkrétně na to.  

Předefinování obchodních příkazů probíhá v IB platformě v základním okně, tlačítko Configure > 
Presets. 

 

Obr. 10.8 – Okno Presets pro globální nastavení příkazů 

Základní okno vypadá na první pohled dost komplikovaně, ale po pochopení základního principu jeho 
ovládání je poměrně snadné. Jak jsme si již několikrát řekli, platforma IB Trader Workstation slouží k 
obchodování obrovského množství finančních instrumentů, a proto také okno obsahuje množství 
„záložek“. Coby intradenní obchodníky nás zajímají pouze vybrané futures kontrakty, proto se 
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budeme zajímat pouze o nastavení záložky FUTURES. Všechny ostatní záložky můžeme s klidným 
svědomím ignorovat, neboť slouží pro představení práce s warranty, opcemi, spready, bondy atd. 

Velmi důležité v tomto okně je tlačítko Create New (vytvořit nové), kterým můžeme do základní 
přednastavené struktury finančních futures instrumentů přidat konkrétní symboly. Při ostrém 
provozu pak program nejprve hledá nastavení pro konkrétní symbol, a teprve pokud jej nenalezne, 
použije obecná nastavení pro danou skupinu (např. FUTURES pro všechny futures kontrakty). Jinými 
slovy – přidáme-li pod záložku FUTURES novou položku ES (označující kontrakt E-mini S&P), pak při 
obchodování futures kontraktu ES bude pro příkazy použito právě nastavení uvedené v dané položce. 
Pokud bychom však obchodovali jiný kontrakt (například YM – E-mini Down Jones), pro který si v 
tomto okně nevytvoříme speciální položku, bude použito globální nastavení uvedené v položce 
Futures.  

A opět, počet informací, které si můžeme nastavit pro jednotlivé kontrakty, je zbytečně široký, 
vycházející z faktu, že okno je univerzální pro nejrůznější finanční instrumenty. Intradenní obchodníky 
bude zajímat pouze několik základních položek (skutečně podstatné položky pro daytrading jsou v 
tabulce označeny tučně): 

 

Obr. 10.9 – přidání šablony příkazů pro futures trh ES 

Výběrem vytvořeného přednastavení pro trh ES dostanete s největší pravděpodobností následující 
zprávu: 
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Obr. 10.10 – dokud nespecifikujete nastavení pro vytvořenou šablonu, použije platforma 
globální nastavení pro Futures 

V záhlaví okna se vám zobrazí 3 tlačítka: 

Override fields only – zobrazí pouze ty možnosti nastavení, které se liší od globálního nastavení pro 
Futures 

All enabled fileds – zobrazí ty možnosti nastavení, které jsou nastavené jako aktivní „měnitelné“ (v 
části Features) 

All possible fields – zobrazí vešketé možnosti nastavení 

Klikneme tedy na tlačítko All enabled fields (případně All possible fields). Uvedené hodnoty můžeme 
upravit podle potřeby: 
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Obr. 10.11 – možnosti nastavení příkazové šablony 

Time in Force – nastavení časové platnosti příkazu. Pro daytrading se vždy příkazy zadávají jako denní 
(Day). 

Allow order to be activated, triggered, or filled outsider of regular trading hours – v případě 
zaškrtnutí lze příkazy zadávat i mimo běžné obchodní hodiny 

Quantity – předdefinované množství obchodovaných kontraktů 

Size Increment – interval, po kterém je zvyšována/snižována hodnota např. s použitím 
nadefinovaných funkčních kláves (není třeba měnit) 

Use closing position size if possible – položka slouží ke specifikaci příkazu při uzavírání pozice. Je-li 
položka zaškrtnutá, systém vytvoří uzavírací příkaz s takovým množstvím kontraktů, rovnajícím se 
počtu kontraktů otevřených v daném trhu. Nejsou-li v trhu žádné otevřené pozice, použije systém 
standardně přednastavený počet kontraktů 
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Use cumulative size for Market Depth – nastavení vztahující se pouze k funkci Market Depth (coby 
samostatnému nástroji, kterému se v této publikaci podrobněji nevěnujeme). V případě zaškrtnutí a 
obchodování skrze okno Market Depth je výše obchodovaných kontraktů rovna celkové aktuální 
nabídce na trhu za danou cenu (tj. pro běžný daytrading nepoužitelné) 

Order Type – umožňuje nadefinovat typ příkazu (nejčastěji používané příkazy pro daytrading jsou 
LMT – limit, MKT – market, STP – stop). Podrobný popis jednotlivých typů příkazů naleznete v dále v 
této publikaci. Intradenní obchodník většinou obchoduje přes nastavená tlačítka okna Book Trader 
(obsahující také definici typu příkazu), a tak výchozí nastavení v tomto okně není příliš podstatné 
(doporučujeme nechat LMT). 

Limit Price – cena, za kterou se bude náš  příkaz aktivovat (v tomto případě limitní příkaz). Můžete 
zvolit buď Ask, Bid nebo Last 

Níže ve formuláři je potom k dispozici nastavení pro příkaz stop-loss a profit-target, které je shodné 
s nastavení, které jsme si ukazovali při popisu funkcí a definování akcí v Book Trader. 
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11 Typy obchodních příkazů a jejich použití 

Pro ucelení našeho povídání o obchodování prostřednictvím IB platformy si pojďme pro jistotu 
zopakovat, jaké základní typy obchodních příkazů se pro intradenní obchodování používají a jak se 
zadávají. 

Market 

Příkaz typu market představuje jeden z nejčastěji a nejsnadněji používaných příkazů. V případě jeho 
použití není obchodníkem specifikována cena, ale obchod je otevřen/uzavřen co nejrychleji s 
použitím aktuální ceny trhu. Nejčastěji se tak příkazy typu market používají pro rychlé uzavření pozic. 
V platformě IB Trader Workstation je příkaz označován zkratkou MKT. 

V momentě odeslání příkazu nebo stisknutí klávesy Buy Market v on-line platformě dojde k otevření 
dlouhé pozice v trhu co nejrychleji za cenu aktuálně dostupnou na trhu. Příkazem typu Market lze 
také velmi rychle uzavřít libovolnou otevřenou pozici – jsme-li například dlouzí v ESU1 (tj. nakoupili 
jsme kontrakt příkazem Buy) a chceme-li pozici okamžitě uzavřít, stačí aktivovat příkaz SELL ESU1 
MARKET.  

Výhodou příkazu Market je tak naprostá jednoduchost jeho zadání. Obchodník se nemůže splést v 
ceně, exekuce příkazu je velmi rychlá. Nevýhodou je skutečnost, že velmi často můžeme získat skluz v 
plnění – cena není garantovaná a zejména v době rychlých pohybů může příkaz dorazit do 
zúčtovacího systému za pár sekund v době, kdy je cena úplně jiná, než kterou jsme v době zadávání 
příkazu v on-line platformě viděli na monitoru. Velmi riskantní je používání market příkazu v méně 
likvidních trzích (ale ty se vesměs nepoužívají pro intradenní obchodování). 

Limit 

Příkazem Limit se pozice otevírá/zavírá za cenu uvedenou v příkazu (nebo lepší). Prioritou plnění není 
tedy čas, ale dosažená cena, která musí být shodná nebo lepší s cenou uvedenou v příkazu. S 
použitím příkazu Limit má obchodník jistotu, že dostane své plánované plnění, nicméně negativem 
příkazu je skutečnost, že trh může obchodníkovi „utéci“, byť se třeba chvilku pohyboval na zadané 
vstupní hodnotě (ale burza nestihla příkaz spárovat třeba z důvodu, že podobných příkazů byla v trhu 
celá řada a na ten náš se již nemusela „dostat řada“). V platformě IB Trader Workstation je příkaz 
označován zkratkou LMT.  

V rámci intradenního obchodování se limitní příkaz používá velmi často – a to jak pro vstup do pozice, 
tak pro výstup na tzv. „profit targetu“ – cílové ceně, za kterou bychom rádi kontrakt uzavřeli. Nákupní 
limitní příkazy je třeba do trhu zadávat s cenou, která je shodná nebo nižší než aktuální obchodovaná 
cena. Prodejní limitní příkazy je třeba do trhu zadávat s cenou, která je rovna nebo vyšší než aktuální 
obchodovaná cena. Zní to komplikovaně, ale v praxi je to velmi snadné, jak si hned ukážeme na 
příkladu. 
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Řekněme, že chceme do trhu YM, kde se aktuální cena (předpokládáme cenu Ask) pohybuje na 
hladině 11000, vstoupit limitním příkazem. Pak v online platformě aktivujeme příkaz: BUY YM 11000 
LIMIT. 

Příkaz bude přístupný patrně přes nějakou horkou klávesu, takže jeho odeslání bude otázkou vteřiny 
(žádné přepisování cen atd.) Příkaz říká, že chceme nakoupit kontrakt YM za cenu maximálně 11000. 
V žádném případě nedostaneme cenu horší – např. 11001 či 11002, což by se nám mohlo stát v 
případě použití příkazu typu market. Dojde-li k plnění, dostaneme cenu 11000 nebo lepší – tj. 
například 10999 (v případě vstupu do dlouhé pozice představuje nižší číslo lepší cenu protože 
„koupíme levněji“). 

Rizikem použití limitního příkazu je fakt, že nemusíme být do trhu exekuováni, pokud ten rychle 
vyrazí zamýšleným směrem. Řekněme, že pošleme do platformy příkaz BUY YM 11000 LIMIT a trh v 
ten samý okamžik poskočí na 11001 a už bude pouze růst – pak bohužel zůstaneme stranou a tohoto 
obchodu se nezúčastníme. 

POZOR! V případě limitního příkazu si musíme dát pozor, abychom nezadali cenu vyšší, než je 
aktuální cena na trhu! Co by se stalo, pokud bychom v našem popisovaném příkladu zadali příkaz BUY 
YM 11010 LIMIT? Říkáme tím – chci otevřít dlouhou pozici za cenu nejhůře 11010 – ale aktuální cena 
na trhu je přitom 11000! Tj. takové plnění nám nějaká protistrana poskytne velmi ráda a my bychom 
byli rázem ve ztrátě 100 USD! Na toto je třeba si dát pozor a naštěstí existují způsoby jak nastavit 
platformy, aby podobné přehmaty hlídaly. 

Limitní příkaz se samozřejmě používá také pro vstup do krátké pozice. Za situace, kdy je na trhu 
aktuální cena 11000 (předpokládáme cenu Bid), bychom mohli pro otevření krátké pozice zadat 
příkaz  

SELL YM 11000 LIMIT  

a nejhorší plnění, které můžeme získat je 11000. Možná získáme 11001 (pozici prodáváme, takže 
vyšší číslo představuje lepší cenu, protože „prodáme dráže“), ale nikdy nezískáme s pomocí tohoto 
příkazu cenu například 10999 nebo dokonce 10998. 

Stop příkaz 

Dalším hojně používaným příkazem je tzv. Stop. V platformě IB Trader Workstation je příkaz 
označován zkratkou STP. Stop příkaz zadaný do trhu není exekuován do doby, dokud se jej cena 
nedotkne – pak se mění v příkaz Market. Tzn. nákupní stop příkaz je do trhu vkládán vždy nad 
aktuální cenu trhu, prodejní pod aktuální tržní cenu. Stop příkaz se nejčastěji používá v případě, že 
obchodník chce vstoupit/vystoupit do/z pozice na určité cenové úrovni – například po překonání 
suportu nebo resistance. Cena plnění není garantována, neboť aktivovaný stop příkaz je de facto 
příkazem Market a plnění může podle aktuální situace v trhu nastat nad i pod zadanou stop cenou. 

Stop limit příkaz 

Alternativou příkazu Stop je příkaz Stop-Limit. V platformě IB Trader Workstation je příkaz označován 
zkratkou STP LMT. Stručně řečeno jde o příkaz prodat nebo koupit, až se trh dotkne určité ceny. V 
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okamžiku, kdy se cena určené hodnoty dotkne, se příkaz mění na příkaz typu limit (tj. omezující 
maximální nejhorší plnění). Podrobně popsané všechny příkazy naleznete na stránkách IB na adrese 
http://www.interactivebrokers.com/en/trading/orderTypesMatrix.php Věnujte přehledu prosím 
pozornost. Některé burzy podporují pouze některé typy příkazů!  

V případě, že burza příkaz nepodporuje, IB takový příkaz simuluje na svém serveru, a to většinou 
pouze v běžných obchodních hodinách dané burzy! Například konkrétně stop příkaz 
(http://www.interactivebrokers.com/en/trading/orders/stop.php?ib_entity=llc) není podporován na 
GLOBEXu, IB jej simuluje, ale pouze během běžných otevíracích časů burzy! A stejně tak stop-limit 
(http://www.interactivebrokers.com/en/trading/orders/stopLimit.php?ib_entity=llc) je na burzách 
např. CBOT, CME, NYSE pouze simulován. 
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12 Uložení pracovního prostředí 

Jak jste již poznali, prvotní nastavení IB platformy může být poměrně zdlouhavé a rozhodně je dobré 
si vytvořené nastavení uložit. Řadu nastavení ukládá IB platforma automaticky, přesto zde existují 
funkce, kterým se vyplatí věnovat pozornost. 

Uložení všech změn nastavení (layout, nastavení parametrů jednotlivých položek a konfigurací) se 
provede příkazem File > Save settings v hlavním menu IB platformy. Tuto funkci rozhodně 
doporučujeme použít po každé změně nastavení IB platformy. Nastavení se uloží do speciálního 
souboru. 

IB platforma umožňuje také uložení a následné vyvolání vlastního pracovního prostoru (Workspace). 
Takto si můžete nadefinovat rozložení několika oken podle vlastních potřeb, toto rozložení si uložit a 
případně se k němu kdykoliv v budoucnu vrátit nebo přepínat mezi několika pracovními prostory 
podle potřeb. Správu pracovních prostorů má na starost funkce Manage Workspaces. K této funkci 
se dostaneme skrze nabídku View > Workspace Controls a poté ve spodní řásti okna platformy 
kliknutím na tlačítko +. Volbou New Workspace se uloží aktuální rozložení oken, funkcí Apply 
Workspace je možné vyvolat dříve uložené nastavení. 

 

Obr. 12.1 – otevření správce pracovní plochy 
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Obr. 12.2 – pomocí nástroje Manage Workspaces si můžeme uložit aktuální rozložení 
oken IB platformy 
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13 Okno Account 

Okno Account obsahuje základní informace o vašem obchodním účtu. Mimo jiné zde naleznete 
základní údaje, jako je zůstatek účtu, souhrn otevřených pozic a blokovaných marginů. 

 

 

Obr. 13.1 – okno Account je dostupné např. přes ikonku v hlavním okně programu nebo 
hlavní nabídku 

Okno se vyvolá kliknutím na hlavní ikonu Account, případně přes hlavní menu Account > Account 
Window. Samotné okno Account je poměrně komplikované a jednotlivá políčka vycházejí ze 
skutečnosti, že účet u IB je univerzální a lze jej použít pro obchodování nejrůznějších finančních 
nástrojů – komodit, akcií, opcí atd. Pro potřeby daytradingu nás zajímá pouze několik málo políček – 
ostatní obsahují různé automatické hodnoty například pro obchodování s akciemi. V případě 
daytradingu e-mini futures tato čísla nemají konkrétní význam a je velká škoda, že jejich zobrazování 
nejde v okně vypnout. 
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Obr. 13.2 – stav okna Account u demo účtu s 500 000 USD 

Na screenshotu je vidět, že se okno Account skládá hned z několika dílčích částí, které si postupně 
představíme.  

Balances 

Zde naleznete veškeré souhrnné informace týkající se použitelného finančního zůstatku daného účtu. 
Částky jsou zobrazovány v měně, ve které je veden daný účet a zůstatek je zobrazován vždy ke 
konkrétnímu času zobrazenému v zápatí okna. 

Margin Requirements 

Velmi důležité okno udává, jaké marginy máme blokované u otevřených pozic. Princip marginů by 
měl být každému jasný z našeho on-line manuálu komoditního manuálu, ale pro rekapitulaci:  

Za otevření pozice s futures kontrakty nikdy neplatíme plnou částku. Díky principu zvanému pákový 
efekt můžeme komoditní futures kontrakt kontrolovat (neboli na určitou dobu vlastnit) za minimální 
zálohu, zvanou margin. Kdykoliv vstoupíme do trhu tím, že nějaký futures kontrakt nakoupíme nebo 
prodáme, tato záloha je nám brokerem zablokována (stržena) z našeho účtu. V momentě, kdy svou 
otevřenou pozici uzavřeme (držený futures kontrakt prodáme nebo prodaný futures kontrakt zpět 
nakoupíme), bude nám naše záloha okamžitě a v plné výši připsána zpět na náš účet. 

Margin se liší podle obchodovaných komodit (obecně platí, že čím dělá kontrakt větší denní pohyby, 
tím je margin vyšší). Přehled marginů u Interactive Brokers naleznete na stránce:  

http://www.interactivebrokers.com/en/trading/marginRequirements/margin_amer.php?ib_entity=u
k 
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Pozor! Marginy se mohou v průběhu času měnit. Současně je třeba vědět, že se marginy rozlišují 
podle toho, zda v pozici zůstáváte přes noc (pak jde o tzv. Overnight margin) nebo zda obchodujete 
pouze intradenně a před uzavřením z trhů vystoupíte (pak jde o tzv. Intraday margin). Intradenní 
obchodování je méně rizikové, a proto jsou u tohoto typu obchodování marginy výrazně nižší. 
Konkrétní výše marginů u všech komoditních kontraktů naleznete na výše uvedené stránce. Např. u 
populárního trhu E-mini Russell 2000 se zkratkou TF si můžeme najít, že margin pro intradenní 
obchodování činí 1 925 USD a pro poziční obchodování 3 850 USD. Znamená to tedy, že pro otevření 
jedné intradenní pozice v trhu TF potřebujeme mít na účtu alespoň 1 925 USD. Pokud bychom chtěli 
zůstávat v pozici přes noc, pak potřebujeme mít na účtu alespoň 3 850 USD. Ještě jednou zopakujme, 
že intradenní pozice je taková, která je obchodována v rámci běžných obchodních hodin daného 
kontraktu a není držena přes noc. Velice důležitá informace je fakt, že IB „přepíná“ mezi intradenním 
a plným marginem přibližně 30 minut před koncem obchodování! 

U marginu narazíte ještě na další dva pojmy – Initial a Maintenance. Na nich není nic složitého. 
Hodnotu u Initial Margin potřebujete mít k dispozici pro otevření obchodu. Je-li Initial Intraday 
Margin 2 500 USD, potřebujete mít na účtu alespoň 2 500 USD. Jakmile jste v pozici, nesmí stav 
vašeho účtu klesnout pod hodnotu Maintenance Margin. Pokud by hodnota vašeho účtu klesla pod 
úroveň Maintenance Margin dostaví se tzv. Margin Call, což v případě IB znamená, že dojde k 
automatickému uzavření otevřených pozic příkazem Market. 

Informace týkající se marginu nalezneme v políčku Current Initial Margin a Current Maintenance 
Margin. Vše podstatné si pojďme ukázat na konkrétním příkladu. 

 

Obr. 13.3 – stav okna Account u demo účtu s 500 000 USD s aktivní otevřenou pozicí 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

59 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

Available for Trading 

Číslo uvedené ve sloupci Total nám říká, kolik financí máme aktuálně k dispozici pro další 
obchodování po odečtení všech blokovaných marginů (máme-li již nějaké pozice otevřené). Podívejte 
se na uvedený obr. 13.2. Jde o demo účet, na kterém máme k dispozici 500 000 USD. 

Market Value 

Okno ve spodní části obrazovky nabízí jiný pohled na aktuální stav financí na účtu – podle 
jednotlivých měn. Většina běžných intradenních obchodníků však pracuje pouze s jednou měnou – 
obvykle americkými dolary, a proto zde bude mít dva stejné řádky – jeden řádek pro USD (ve které 
provádíme obchodování) a druhý pro základní měnu účtu (kterou bývají také USD). V tomto bloku je 
pro daytrading aktuální pouze sloupec Total Cash udávající aktuální hodnotu účtu, a to včetně 
otevřených ztrát/zisků (hodnota tedy udává, kolik peněz by bylo na účtu k dispozici v tomto 
okamžiku, kdyby se nyní zavřely všechny otevřené pozice). Stejnou hodnotu nalezneme ve sloupci 
Net Liquidation Value. Poslední zajímavý je sloupec Realized Pnl, který v rámci daytradingu udává 
celkovou hodnotu zisku/ztráty za daný obchodní den. 

Portfolio 

Jak napovídá název tohoto bloku, nalezneme zde informace o realizovaných obchodech – tedy o 
kontraktech, které máme v našem portfoliu. V případě daytradingu jsou zde uvedeny všechny naše 
otevřené pozice. Pro daytrading jsou opět podstatné pouze některé položky. 

 

Obr. 13.4 – stav okna Porfolio 

Sloupec Contract description obsahuje specifikaci nakoupeného kontraktu. Patrně nejdůležitější 
políčko Position udává, zdali jsme v trhu dlouzí nebo krátcí a kolik máme otevřeno kontraktů. Kladné 
číslo udává, že jsme v trhu dlouzí (tj. máme kontrakt nakoupený příkazem Buy – očekáváme růst 
ceny), záporné číslo udává, že jsme v trhu krátcí (tj. máme kontrakt prodaný příkazem Sell – 
očekáváme pokles ceny). Samotné číslo udává počet kontraktů. V případě, že je v políčku uvedeno 
číslo „2“, znamená to, že máme otevřené 2 kontrakty ES v dlouhé pozici. Položka Market Price udává 
aktuální cenu na trhu, což není na tomto místě v případě daytradingu příliš podstatné. Ostatní 
položky jsou aktuální pouze pro akcie. 

Všimněte si, že tabulka obsahuje také zaškrtávací políčko Show zero position rows. V případě 
zaškrtnutí této položky se v přehledu objeví i uzavřené pozice. Náš tip je zobrazovat v této části účtu 
pouze otevřené pozice (kdy tak vždy vidíme, zdali máme nebo nemáme v trhu nějaké pozice 
otevřené), a tudíž tuto volbu nechat nezaškrtnutou. 

Všimněte si, že i v menu účtu je k dispozici jedna z dalších možností, jak zavřít naše pozice. Konkrétně 
jde o položku Portfolio > Close All Positions (zavřít všechny otevřené pozice). 
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Doplňující screenshoty 

Jak vidíte, okno Account sice obsahuje spoustu informací, nicméně pro potřeby daytradera je jich zde 
opravdu minimum a není problém se v okně dobře orientovat. Na následujících dvou screenshotech 
najdete komentovaný popis situací, vycházejících z příkladů popisovaných v této kapitole. 

 

Obr. 13.5 – aktuální stav účtu je 501 252,01 USD, což vychází z faktu, že předchozí pozice 
nám přinesla +1 252 USD. V tuto chvíli máme všechny pozice uzavřené, a proto není na 
účtu blokován žádný margin 
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Obr. 13.6 – stav okna Account v okamžiku, kdy jsme otevřeli další pozici v trhu ES, 
tentokrát však příkazem Buy – jsme tedy v trhu dlouzí s deseti kontrakty. Tato skutečnost 
je vidět v okně Portfolio, kde je ve sloupci Position uvedena hodnota „10“. Aktuální 
otevřená pozice je ve ztrátě 211,50 USD (tato informace je dostupná přes modul Book 
Trader, v okně Account není bohužel vidět ziskovost/profitabilnost jednotlivých 
otevřených pozic). Všimněte si okna Market Value – Total Cash je 501 040,51 USD, která 
je tvořena poslední stavem účtu + ziskem/ztrátou z aktuálně otevřené pozice 

 

 

 

 

 

 

 

 

 

 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

62 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

14 Grafy trhů v IB platformě 

IB platforma obsahuje v sobě základní nástroje pro grafické znázorňování cen trhů. Nástroj je tvůrci 
neustále vyvíjen, podle našeho názoru jej však zatím nelze příliš použít pro účely daytradingu, kde 
trader potřebuje mít k dispozici skutečně velmi rychlý, přehledný a flexibilní nástroj. Proto sami zatím 
používáme pro grafické zobrazování nástroj SierraChart, který je napojen na IB pomocí API rozhraní 
(vše popsáno dále).  

Nicméně pro základní grafické zobrazování cenových průběhů je nástroj grafy IB platformy určitě 
dobře použitelný, a proto si jej krátce představíme. 

Graf lze u kontraktu vyvolat několika způsoby. Vždy je třeba si v hlavním okně IB platformy označit 
řádek s daným kontraktem. Buď lze na jméno kontraktu kliknout levým tlačítkem myši a následně 
nahoře zvolit ikonu Chart, nebo jsou grafy přístupné přes kontextové menu. V tomto případě klikněte 
na název kontraktu pravým tlačítkem myši a z kontextového menu vyberte Charts > New Chart. Další 
možností je pak hlavní menu platformy: nabídka Analytical Tools > Chart. 

 

Obr. 14.1 – grafy jsou u jednotlivých symbolů dostupné například přes kontextové menu 
vyvolané kliknutím pravého tlačítka myši 

Po otevření okna grafu máte možnost provést změnu parametrů grafu přes nabídku Edit > Chart 
Parameters, kterou si nyní popíšeme. 
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Obr. 14.2 – základní nastavení pro zobrazení kontraktu E-mini S&P. Graf bude zobrazen 
jako dvouminutový, bude obsahovat volume a bude obsahovat historii za poslední den 

Time Period – období, za které chceme graf zobrazit. Např. 5 min zobrazí graf pouze s historií 5 
minut, 1 day zobrazí graf s historií jeden den 

What to show – typ ceny, který je do grafu zakreslován. Traders znamená ceny, za které proběhla 
skutečná exekuce (myšleno obecně – na burze), Midpoint představuje prostřední hodnotu mezi 
cenou Bid/Ask. Bid/Ask bude zobrazovat nejlepší možné ceny, za které bylo možné prodat nebo 
koupit (Bid/Ask) 

Bar Type – typ zobrazovaného grafu. Candlestick jsou klasické svíčkové grafy, High Low Bar je graf, 
kde jedna svíce je určena pouze rozsahem ceny High a ceny Low 

Volume Plot Height – výška oblasti se zobrazeným Volume 

Show … bars – počet zobrazených cenových úseček na grafu 

Additional Data and Features – zobrazuje různé možnosti k zobrazení grafu. Např. si můžete zobrazit 
mimo aktuálně vykreslovanou cenu Last také cenu Ask a cenu Bid a jiné. Většinu těchto nastavení 
můžete ponechat 
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Chart Time Options – volba Keep chart up-to-date zajišťuje pravidelnou aktualizaci grafu. 
Nezatrhnutá volba Show data in user time zone znamená, že platforma bude zobrazovat na časové 
ose čas, který se váže k danému trhu. Pokud zatrhnete tuto volbu, časová osa se upraví podle vašeho 
aktuálního času 

Bypass this dialog when opening a new chart – pokud zrušíte zatržení této volby, bude se tento 
dialog nastavení grafu zobrazovat při každém otevření nového grafu tak, abyste si vždy mohli 
okamžitě upravit potřebná nastavení 

Základní prostředí grafu je vidět na obrázku 14.2. Grafické java prostředí nenabízí žádnou přehršel 
nástrojů pro technickou analýzu, nicméně alespoň ty základní k dispozici jsou – najdeme je v horní 
liště pod menu. De facto jde pouze o nástroje pro kreslení a mazání křivek. Nástroj s jednou šikmou 
čárou slouží ke kreslení trendové linky. Po zvolení tohoto nástroje klikněte levým tlačítkem do grafu, 
táhněte linku a klikněte znovu. Nástroj se dvěma šikými čarami slouží k duplikování nakreslené 
trendové linky. Nakreslené trendové linky je pak možné mazat nástrojem s přeškrtnutou šikmou 
linkou. 

Pro dobrou orientaci v grafu je možné použít odečítací kříž (ikonka s křížem) nebo vodorovné či 
vertikální čáry (ikonka s vodorovnou, resp. svislou čárou). 

Platforma umožňuje měnit také globální nastavení grafů, možnosti nástrojových lišt a jiné. 
K nastavení se dostanete kliknutím pravým tlačítkem na horní levou část grafu a následnou volbou 
Global Chart Configuration. 

 

Obr. 14.3 – platforma nabízí možnost další výchozí konfigurace pro všechny grafy a také 
možnost úpravy nástrojových lišt a jiné 
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Obr. 14.4 – globální nastavení vzhledu okna grafu 

V globálním nastavení si můžete např. změnit zobrazování některých informací, nástrojových lišt, 
zarovnání cenové a časové osy, informačních boxů a jiné. Pokud se rozhodnete obchodovat „přes 
grafy“, pak doporučujeme přizpůsobit si vzhled pracovní plochy grafu ke svému pohodlí. 

Než přejdeme k použití a nastavení indikátorů, zmíníme se ještě v krátkosti o možnosti obchodování 
přímo z grafu. Tato funkce je vyhledávána převážně diskréčními obchodníky a platforma TWS ji také 
nabízí. 

Po otevření grafu máte k dispozici základní tlačítka pro zadání příkazu přímo grafu (viz. obr. 14.6). Zde 
však chybí tlačítko pro zrušení aktivní nevyplněných příkazů a pro rychlé uzavření otevřené pozice. 

Zde doporučujeme zobrazit si (pokud již není zobrazen) dodatečný panel s více tlačítky rychlé volby. 
To provedete v globálním nastavení platformy v části Charts > Settings a zaškrtněte volbu Buttons 
Panel. 
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Obr. 14.5 – aktivace panelu s tlačítky rychlé volby 

Po aktivaci se pod grafem zobrazí panel s tlačítky pro kontrolu příkazů. Příkaz k nákupu zadáme 
tlačítkem Buy a kurzorem zvolíme cenu 1124.25. Pokud souhlasí všechny parametry příkazu (viz. 
spodní záložka Orders), pak klikneme na tlačítko Transmit nebo na tlačítko T přímo v grafu. 

 

Obr. 14.6 – příkazy lze zadávat také pomocí tlačítek přímo v grafu 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

67 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

V případě, že chceme příkaz zrušit, můžeme tak učinit kliknutím na tlačítko Cancel All Orders 
případně na žluté C přímo v grafu. Tlačítko Close Position pak slouží k okamžitému uzavření všech 
otevřených pozic v trhu. 
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Práce s indikátory 

Přes menu v grafu Edit > Studies lze do grafu přidat řadu indikátorů. Jako příklad přidáme do grafu 
exponenciální klouzavý průměr s periodou 34. 

Po zvolení příslušného indikátoru IB nabídne dialogové okno, ve kterém lze nastavit parametry 
indikátoru. Po odklepnutí OK je indikátor zobrazen v grafu. 

Chcete-li indikátor z grafu odstranit nebo jej změnit, klikněte pravým tlačítkem v grafu na příslušný 
indikátor. Chcete-li indikátor odstranit, pak v následně zobrazeném dialogovém okně klikněte na 
tlačítko Remove Indicator. Pokud jej chcete upravit, klikněte na Edit Indicator. 

 

Obr. 14.7 – přidání indikátoru Exponential Moving Average do grafu 

 

Obr. 14.8 – nabídka akcí vyvolaná kliknutím pravým tlačítkem na indikátor v grafu. Zde je 
možno změnit například barvu indikátoru v grafu pomocí Change Indicator Color 
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15 Trader Workstation API 

Velkou výhodu obchodní platformy Interactive Brokers je tzv. API. Jde o programovací rozhraní 
aplikace (v angličtině Application Programming Interfaces) umožňující napojit na platformu 
nejrůznější další programy a aplikace. Tyto aplikace pak mohou přes API získávat z IB platformy 
například aktuální ceny, pracovat s obchodními příkazy, zjišťovat stav otevřených pozic či pracovat s 
informacemi o obchodním účtu. 

API aplikací pro IB platformu existuje celá řada a mnoho je jich zdarma. Důvodem, proč je používat, je 
fakt, že tyto aplikace se většinou specializují na určitou činnost a jejich ovládání je mnohem snazší, 
přehlednější a efektivnější než univerzální rozhraní IB platformy. 

Dopředu je však třeba upozornit na skutečnost, že na svůj počítač by si každý uživatel měl instalovat 
pouze takové aplikace, kterým absolutně důvěřuje a které mají na internetu obecně dobré reference. 
Nezapomínejte, že tyto aplikace jsou přes API napojené přímo na váš obchodní účet a plně tak 
ovládají vaše reálné peníze, které jste svěřili na účet u Interactive Brokers. 

Kompletní dokumentaci pro vývojáře naleznete na adrese: 
http://www.interactivebrokers.com/php/apiUsersGuide/apiguide.htm 

V rámci této publikace si představíme pouze několik API aplikací, které sami používáme pro aktivní 
trading. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.financnik.cz/
http://www.financnik.cz/
http://www.interactivebrokers.com/php/apiUsersGuide/apiguide.htm


Intradenní obchodování s Interactive Brokers www.financnik.cz  

70 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

Konfigurace API 

Před používáním API aplikací je třeba nejprve API rozhraní nainstalovat a nakonfigurovat. Proces se 
skládá z několika kroků. Nainstalujte si poslední verzi API. Software je k dispozici na adrese: 
http://individuals.interactivebrokers.com/en/p.php?f=programInterface&ib_entity=llc (dostupné z 
homepage Interactive Brokers přes menu Trading > API Solutions > IB API Na této adrese si stáhněte 
soubor z prvního sloupce (Windows – Download latest version), soubor se jmenuje InstallAX.exe. Po 
stažení soubor spusťte a nechte proběhnout instalaci. 

Nyní spusťte IB Trader Workstation a v menu Configure > API zaškrtněte položku Enable ActiveX and 
Socket Clients (viz obr. 15.1). Doporučujeme také zaškrtnout položku Enable DDE clients a v části 
Trusted IP Addresses přidat IP adresu 127.0.0.1 pomocí tlačítka Create. Tímto povolíte přístup 
k platformě z lokálního počítače a zpřístupníte prostředí IB Trader Workstation pro API aplikace, 
které si nainstalujete na svůj počítač. Nicméně nemusíte se bát, že by platformu ovládaly kdejaké 
aplikace – přístup každé aplikace je nutné ručně potvrdit při jejím spuštění. 

 

Obr. 15.1 – používání API je nutné v IB platformě nejprve povolit 
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16 SierraChart – základní propojení s IB 

Jednou z oblíbených aplikací, která je často propojována s platformou IB Trader Workstation, je 
platforma SierraChart. Samotné prostředí IB platformy umí také zobrazovat grafy (jak jsme si ukázali 
dříve), ale s možnostmi programu SierraChart jde o nesrovnatelné řešení. Výhodou SierraChart je 
možnost využívání množství indikátorů, studií a nástrojů pro technickou analýzu trhů při rozumné 
ceně programu (základní verze programu stojí 168 USD na rok). Zde je však potřeba informovat se 
přímo u výrobce SierraChart, zdali základní verze této platformy podporuje napojení na IB API. 
Intradenní data v reálném čase umí SierraChart získávat automaticky z platformy IB Trader 
Workstation, v programu lze zobrazovat i EOD data. Na serveru Finančník.cz věnujeme platformě 
SierraChart samostatnou část, kterou naleznete na adrese http://www.financnik.cz/exe/sierra/ 

Na našem serveru Finančník.cz jsme vyhradili také část diskusního fóru platformě SierraChart, kde se 
může obracet s dotazy a žádostmi o pomoc s nastavením. 

V této kapitole se nebudeme podrobně věnovat jednotlivým funkcím programu SierraChart, ale 
popíšeme si pouze problematiku propojení software s IB platformou přes API. 

Nastavení připojení k API 

Po instalaci programu se ujistěte, že máte povolené API v prostředí IB Trader Workstation (viz 
Konfigurace API v předcházející kapitole). Také se ujistěte, že v nastavení API > Settings je u položky 
Socket Port nastavena hodnota 7496.  

Spusťte program SierraChart. Při prvním spuštění je třeba zadat uživatelské jméno a heslo pro vstup 
do programu SierraChart. Tyto údaje jste získali na stránce výrobce programu při nákupu software (tj. 
nejde o přístupové údaje do IB platformy). 

Jakmile je program spuštěn, je třeba nastavit jeho propojení s IB platformou. Ujistěte se, že máte 
spuštěnou platformu IB Trader Workstation a v programu SierraChart zvolte dialogové okno File > 
Data/Trade  Service Settings. 
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Obr. 16.1 – nastavení propojení programu SierraChart s IB platformou. Toto je kompletní 
funkční nastavení – není zde třeba vyplňovat žádná jména ani uživatelská jména. 

Okno Data/Trade Service Settings je třeba nastavit tak, jak vidíte na screenshotu 1. V podstatě je 
nutné nastavit pouze položku Server na hodnotu localhost:7496. 

Zaškrtávací políčka mají následující význam: 

Connect on startup – po spuštění SierraChart dojde automaticky k navázání spojení s IB platformou. 
Doporučujeme zaškrtnout. 

Reconnect on failure – automaticky znovunaváže spojení s IB platformou v případě nějakého 
výpadku. Určitě doporučujeme zaškrtnout. 

Download intraday data backfill – zaškrtnutím volby si program vyžádá automatické doplnění 
historických dat na zobrazených grafech (tzv. backfill). IB poskytuje backfill za 24 hodin, tj. v případě 
zaškrtnutí volby budou do grafů doplněny hodnoty za posledních 24 hodin. Pozor! Tato volba 
nefunguje při práci s demoverzí IB! Při práci s ostrou verzí programu doporučujeme zaškrtnout. 

Time Zone – vaše časové pásmo 

Intraday Data Storage Time Unit – formát ukládání dat (ticková, 1-sekundová, 2-sekundová, atd.) 

Time and Sales Settings – povolení ukládání dat pro Time and Sales s nastavením počtu záznamů 

http://www.financnik.cz/
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Jakmile máme Sierru nastavenou podle popisu v předcházející kapitole, nic již nebrání tomu nechat si 
v programu zobrazit grafy na základě dat poskytovaných z IB platformy.  

Ujistěte se, že máte spuštěn jak program SierraChart, tak IB Trader Workstation. Současně se ujistěte, 
že oba programy jsou propojeny. Pozná se to například tak, že v menu File programu SierraChart je 
volba Connect to Data Feed zobrazena šedivě a aktivní je naopak volba Disconnect. 

 

Obr. 16.2 – otevření nového grafu po připojení platformy ke zdroji dat 

Nyní si vytvoříme první graf. Řekněme, že chceme zobrazit aktuální kontrakt trhu E-mini S&P. Tento 
symbol má zkratku ES, nicméně IB pracuje se speciálním formátováním, které je třeba respektovat i v 
prostředí dalších programů napojených přes API rozhraní. 

Konkrétně prosincový kontrakt trhu E-mini S&P má následující označení: ES-201109-CME. Na první 
pohled komplikovaný řetězec má naštěstí poměrně logickou strukturu. ES je označení kontraktu, 
201109 označení kontraktního měsíce (září 2011), a CME je označení burzy, na které E-mini S&P 
obchoduje. 

Zde jsou kódy pro další kontrakty běžně používané pro daytrading (všechna označení se vztahují k 
prosincovému kontraktnímu měsíci – toto je třeba změnit podle aktuálního měsíce, kdy čtete tuto 
publikaci). 

E-mini DJ – YM-201109-CBOT 

DAX – FDAX-201109-Eurex 

30yrs T-Bonds – ZB-201109-CBOT 

Zpět k našemu kontraktu mini S&P, který si chceme zobrazit do podoby intradenního grafu. V menu 
SierraChart klikneme na volbu File > New/Open Intraday Chart (případně lze rychle aktivovat přes 
klávesovou zkratku CTRL + I). Otevře se dialogové okno, ve kterém můžeme vybrat dříve uložený graf. 
Jelikož však graf otevíráme poprvé, vložíme označení trhu do políčka „Název souboru“ a dáme 
Otevřít. 

http://www.financnik.cz/
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Obr. 16.3 – název kontraktního měsíce vložíme do políčka „Název souboru“ a klikneme 
na tlačítko Otevřít 

V tento okamžik je vše hotovo. V programu už je k dispozici graf trhu E-mini S&P. Graf je propojen s 
platformou Interactive Brokers a bude se automaticky aktualizovat podle aktuální ceny trhu. Graf 
nezapomeňte uložit volbou File > Save – při příštím použití programu stačí otevřít pouze příslušný 
soubor. Graf včetně všech případných indikátorů a propojení na IB platformu budete mít opět k 
dispozici. 
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Sice jsme si řekli, že v rámci této publikace se nemůžeme podrobně samotnému programu 
SierraCharts věnovat, nicméně některé základní stručné tipy pro vás máme: 

Tlačítko F5 (nebo volba v menu Chart > Chart Settings) vyvolá dialogové okno umožňující základní 
nastavení grafu (změna měřítka, změna typu zobrazování cen, atd.). 

 

Obr. 16.4 – okno Chart Settings ovlivňující základní nastavení zobrazovaného grafu. 

V dialogovém okně Chart Settings jsou nejdůležitější tato políčka: 

Days to Display/Load – zde se nastavuje počet zobrazovaných dnů. Chcete-li zobrazit data např. za 
celý měsíc, tak zadejte číslo 60. Nicméně tato volba je dobrá v případě, že již máte historii dat 
uloženou nebo ji čerpáte z nějakého placeného zdroje. Samotný IB umí backfill pouze za den zpětně. 

http://www.financnik.cz/
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Graph Type – zde nejčastěji nastavujete, jestli chcete formát grafu zobrazovat pomocí klasických 
úseček (OHLC Bar) nebo pomocí svíček (Candelstick).  

Intraday Bar Period – políčko Bar Period – toto pole říká, jaký formát pro zadání timeframe bude pro 
zobrazení grafu použit. Hodnota Days-Mins-Secs může být např. zadána následovně: 

Hodnota 0-0-30 značí třicetisekundový graf, hodnota 0-3-0 značí tříminutový graf, 1-0-0 denní graf 
atd. V sekci Start Time a End Time si můžeme nastavit časový interval, který chceme na grafech 
zobrazovat (např. pro případ, že nechceme zobrazovat noční průběhy). 

Tlačítko F6 (nebo funkce Tools > Studies) vyvolá okno Chart Studies umožňující přidávání 
nejrůznějších indikátorů do grafu. Indikátor se přidá do grafu tak, že se v levém okně klikne na 
příslušné jméno indikátoru a poté použije tlačítko Add>>. Tlačítkem Settings je možné měnit 
nastavení vybraného indikátoru. 

 

Obr. 16.5 – na pravé straně okna je seznam aktuálně používaných indikátorů 

U indikátorů lze nastavovat barvy, kterými je indikátor a jeho součásti zobrazován (záložka 
Subgraphs) a samozřejmě všechny možné hodnoty ovlivňující průběh indikátoru (záložka Settings and 
Inputs) – tato nastavení se liší podle jednotlivých zvolených nástrojů. Zajímavá je také záložka Alerts, 
kde si za pomoci různých podmínek můžete nastavit upozornění na určitý stav indikátoru (více 
v nápovědě k platformě SierraChart pod heslem „study alerts“). Důležité políčko je volba Chart 
Region, pomocí které lze indikátory sdružovat do stejných oken, nebo naopak zobrazovat 
samostatně. Pokud dvěma indikátorům přiřadíte hodnotu „2“, budou zobrazeny najednou ve stejném 
okně pod hlavním grafem. 

 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

77 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

 

Obr. 16.6 – detailní nastavení parametrů indikátoru (studie) 

Důležitá je funkce uložení nastavení indikátorů coby kolekce, kterou lze poté jedním kliknutím 
aplikovat v budoucnu na kterékoliv další grafy. Jméno kolekce zapíšeme do políčka Study Collection 
list a klikneme na tlačítko Save All. Takto uloženou kolekci naleznete kdykoliv v budoucnu v nabídce 
Analysis a je možné ji aplikovat na libovolný graf. 
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Obr. 16.7 – menu Tools obsahuje všechny dostupné nástroje technické analýzy pro práci 
s grafem 
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17 NinjaTrader – základní propojení s IB 

NinjaTrader je na svoji cenu velmi dobré a především univerzální řešení pro diskréční obchodování a 
nejen pro něj. Platforma umožňuje jak obchodování z klasického DOMu, tak z grafu. Dále umožňuje 
sledovat hloubku trhu, Time and Sales, provádět automatický backtest včetně optimalizace a 
walkforward analýzy (umožňuje dokonce využít genetické algoritmy). Samozřejmostí je také funkce 
Market Replay pro přehrávání historických dat včetně Level 2. 

Na našem serveru věnujeme této platformě celý seriál článků k NinjaTrader a také část naší 
wiki, která vám může posloužit jako rozcestník za informacemi, které potřebujete. 

Pokud jste platformu NinjaTrader ještě nevyzkoušeli, doporučujeme vyzkoušet verzi FREE, která má 
pouze to omezení, že nemůžete využívat automatické obchodní strategie, obchodovat přímo z grafu 
apod. Pro začínající obchodníky tuto platformu můžeme jen doporučit. 

Vaše dotazy k platformě NinjaTrader můžete směřovat do diskusního vlákna NinjaTrader - prosím 
o radu nebo do vlánka Ninja Trader - nastavení programu od A do Z.  

Nastavení připojení k API 

Nejprve je potřeba otevřít platformu IB TWS a ujistit se, že máme povoleno, že ostatní programy 
mohou čerpat data přes API. To uděláte jednoduše. Klikneme na Configure a vyberme položku API > 
Settings. Následně zaškrtneme první dvě nabídky: 

Tím má NinjaTrader povoleno čerpat z TWS IB data. 

Nyní spustíme platformu NinjaTrader a v kontrolním centru vybereme Tools > Account 
Connections….  

 

Obr. 17.1 – nastavení připojení se provádí z kontrolního centra 

Nyní klikneme na tlačítko Add. 
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Obr. 17.2 – zde přidáme nové připojení k IB 

Následující formulář vyplníme podle obrázku. Název připojení je volitelný. 

 

Obr. 17.3 – průvodce připojením nám umožní nastavit všechny důležité parametry 

Po kliknutí na tlačítko Next dostaneme následující formulář: 
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Obr. 17.4 – detailní nastavení parametrů připojení k TWS 

User name – vaše uživatelské jméno k účtu Interactive Brokers 

Password – vaše heslo k účtu Interactive Brokers 

Host – zde ponechte hodnotu localhost. Pokud byste měli vaši platformu TWS nainstalovánu na jiném 
počítači v síti, pak je potřeba uvést IP adresu tohoto počítače 

Port – stejná hodnota nastavení portu jako v platformě TWS,obvykle tedy hodnota 7496 

Client ID – ponechte hodnotu „0“ 

Trigger after hours – umožňuje vyplnění příkazů i mimo hlavní obchodní hodiny. Aby tato funkce 
pracovala správně, je potřeba v platformě TWS povolit následující nastavení: „Allow order to be 
activated, triggered, or filled outside of regular trading hours“. Toto nastavení naleznete v TWS pod 
Configure > Order > Order Presets > Timing menu 

Auto logon – volba umožňuje platformě NinjaTrader automatické po spuštění provést připojení 
k platformě TWS 

Run-time pop up handling – aktivace této funkce umožní platformě NinjaTrader potlačit pop-up 
oznámení TWS platformy 

SSL – aktivuje zabezpečení přenosu dat SSL 

http://www.financnik.cz/
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Local OCO simulation – povoluje platformě NinjaTrader simulovat OCO příkazy 

Use user settings – umožní platformě NinjaTrader používat uživatelské nastavení TWS 

Trade Currencies (FX) – pokud obchodujete forex přes Interactive Brokers, aktivujte tuto volbu 

Za zmínku stojí také práce s grafy v této platformě. Její předností je především jednoduchost. Máme 
tím na mysli např. to, že v platformě nenaleznete příliš „zbytečností“. Jsou zde však k dispozici 
všechny nezbytné nástroje pro technickou analýzu. Oproti SierraChart je NinjaTrader maličko 
náročnější z pohledu hardware, ale v dnešní době dvou a více jádrových procesorů je to již 
zanedbatelný rozdíl. 

Po připojení můžete v platformě zobrazit graf jednoduše kliknutím na menu File > Chart. 

Zadáním symbolu (v našem případě ES 09-11) a kliknutím na tlačítko New, si můžete zobrazit 
požadovaný graf trhu. NinjaTrader používá oproti platformě SierraChart jiný formát zadání 
kontraktních měsíců futures. Pokud si nejste jistí, jaké označení má vámi požadovaný finanční 
instrument, můžete použít vyhledávač instrumentů. Ten otevřete kliknutím na tlačítko vedle políčka 
pro zadání označení instrumentu. 

 

Obr. 17.5 – ve vyhledávači jsme si nechali zobrazit všechny trhy na výraz „oil“ 
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Po vybrání instrumentu, můžete zvolit parametry zobrazovaného grafu. Nabízí se několik možností: 

Type – můžeme zvolit typ grafu. V nabídce je možnost zvolit jak klasické (časové), tak alternativní 
grafy 

Days to load – počet zobrazených dnů na grafu 

End date – datum posledního zobrazeného dne 

Session template – rozsah zobrazení cen během dne. Můžete zvolit např. zobrazení celých 24 hodin, 
případně pouze časový rozsah pro obchodování US trhů (od 15:30 do 22:15) apod. 

Chart style – můžete zvolit mezi svíčkovým grafem, klasickým čárovým grafem a jinými variantami 
zobrazení cen 

Ve výbavě platformy jsou samozřejmě také nástroje pro práci s grafem. K dispozici jsou trendové 
linky, fibonacciho úrovně a jiné. 

 

Obr. 17.6 – nástroje pro práci s grafem jsou dostupné s nástrojové lišty 

NinjaTrader samozřejmě disponuje sadou nejpoužívanějších indikátorů, které lze snadno přidat do 
grafu kliknutím pravým tlačítkem na graf a vybráním volby Indicators. Požadovaný indikátor 
jednoduše přidáte do grafu tak, že kliknete na jeho název v seznamu dostupných indikátoru a poté 
kliknete na tlačítko New. Nyní již zbývá pouze zadat parametry vybraného indikátoru a zvolit vhodné 
barevné nastavení. Pokud chcete indikátor odstranit, vyberte jej ve spodní části a klikněte na tlačítko 
Remove. 
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Obr. 17.7 – nyní máme v grafu aktivní dva indikátory – RSI (10, 3) a EMA (14) 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.financnik.cz/
http://www.financnik.cz/


Intradenní obchodování s Interactive Brokers www.financnik.cz  

85 
Tato publikace je chráněna autorským zákonem. Jakékoliv rozmnožování a šíření je zakázáno. 

Držitelem autorských práv je www.financnik.cz  
 

18 MultiCharts – základní propojení s IB 

Mezi velice zajímavé obchodní platformy patří bezesporu také řešení nazvané MultiCharts. Dalo by se 
říci, že MultiCharts je program "vše v jednom". Jedná se o univerzální analytickou platformu s velmi 
uživatelsky příjemným a intuitivním ovládáním, která v základu nabízí následující: 

- libovolnou analýzu grafů 
- libovolnou práci s nejrůznějšími typy grafů 
- libovolnou práci s bezpočtem indikátorů 
- využití genetických algoritmů 
- velmi rychlý backtest s velmi komplexním reportem 
- data playback, market scanner 
- automatické obchodování 

Více o platformě MutliCharts se dozvíte v naší mini-recenzi. V krátkosti jen zmíníme, že platforma 
nabízí i verzi pro diskréční obchodování, zvanou MultiCharts DT. Jedná se sice o výrazně jednodušší 
verzi, která je uzpůsobená skutečně jen pro diskréční obchodování (chybí nástroje pro automatické 
backtestování a automatické optimalizace). Tato verze je zcela zdarma a obsahuje prakticky vše, co je 
potřeba pro diskréční obchodování. 

Platformu MultiCharts si můžete stáhnout zde. 

Nastavení připojení k API 

Nejprve je potřeba otevřít platformu IB TWS a ujistit se, že máme povoleno, že ostatní programy 
mohou čerpat data přes API. To uděláte jednoduše. Klikneme na Configure a vyberme položku API > 
Settings. Následně zaškrtneme první dvě nabídky: 

Tím má MultiCharts povoleno čerpat z TWS IB data. 

Nyní otevřeme program MultiCharts. Klikneme na ikonku, která slouží k otevření nového grafu (viz 
obr. 18.1), v DataSource (zdroj dat) vybereme Interactive Brokers a klikneme na tlačítko Add…, které 
slouží k přidání trhu, jehož graf chceme otevřít, do seznamu „rychle dostupných“ trhů v platformě 
MultiCharts. 
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Obr. 18.1 – přidání instrumentu mezi „rychle dostupné trhy“ z vybraného datového 
zdroje 

Následně se objeví okno, které slouží k rychlému a snadnému vyhledání daného trhu. Pokud chceme 
například zobrazit aktuální graf trhu E-mini S&P, pak klikneme na záložku Future, do okénka 
napíšeme zkratku trhu (ES) a klikneme na tlačítko Lookup. Pokud je vše správně propojené, 
MultiCharst nyní vyhledá veškeré dostupné kontrakty ES u Interactive Brokers a zobrazí níže. 
Aktuálně obchodovaný je kontraktní měsíc ESU1, který tedy vybereme a klikneme na tlačítko Add….  
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Obr. 18.2 – potvrdíme výběr instrumentu, který se přidá mezi naše vybrané trhy 

Tím se kód symbolu uloží v rychlé nabídce trhů v záložce Futures v programu MultiCharts (viz obrázek 
níže) a zůstane již uložený – příště tedy již nebude nutné celý postup opakovat. 
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Obr. 18.3 – přehled přidaných instrumentů 

Nyní zbývá nastavit druh grafu a timeframe, což uděláme kliknutím na záložku Settings. 
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Obr. 18.4 – nastavení parametrů pro zobrazení grafu 

Pokud jsme vše udělali správně, jsme hotovi a v programu MultiCharts se vám objeví váš první graf. 
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19 Závěrem 

Na předchozích téměř 90 stranách jsme si popsali základní funkce platformy IB potřebné pro 
daytrading. Navíc jsme si ukázali další možnosti využití platformy díky rozraní API. Pevně doufáme, že 
Vám tato publikace pomohla k vyřešení řady technických otázek spojených s platformou a řádně Vás 
tak připravila na čistě technickou stránku obchodování. 

Závěrem zbývá dodat pouze jedno: I když je volba správného technického řešení on-line obchodování 
důležitá, neupadejte prosím v dojem, že vyřešit správně technické aspekty obchodování je to 
nejdůležitější. Zisky byly, jsou a budou tvořeny vždy a jen díky obchodníkově mysli a pevné disciplíně, 
a tak nedisciplinovanému obchodníkovi nepomohou k ziskům ani sebelepší technická řešení. 

Přejeme vám do budoucna mnoho obchodních úspěchů. Pokud jste byli s publikací spokojeni, 
prosíme, podělte se v našem diskusním fóru na serveru http://www.financnik.cz/forum/list.php?10 

Mnoho úspěchů, 

 

 

Petr Podhajský & Tomáš Nesnídal 

FINANČNÍK.CZ 
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